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electronic, mechanical, photocopying, recording or otherwise, without the prior
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Trademarks
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may be registered in some jurisdictions. Windows and Windows 95 are registered
trademarks and Windows NT is a trademark of Microsoft Corporation in the U.S
other countries used under license.

All other trademarks are owned by their respective owners.

ASUS and ASUSTeK are registered trademarks of ASUSTeK COMPUTER INC.

Changes
The material in this document is for information only and is subject to change
without notice. While reasonable efforts have been made in the preparation of thi
document to assure its accuracy, Adaptec, Inc. assumes no liability resulting from
errors or omissions in this document, or from the use of the information containe
herein.

Adaptec and ASUSTeK reserves the right to make changes in the product design
without reservation and without notification to its users.

Adaptec Technical Support and Services
If you have questions about installing or using your Adaptec product, check this
user’s guide first—you will find answers to most of your questions here. If you n
further assistance, please contact us. We offer the following support and informat
services:

Electronic Support
Technical information, including product literature, answers to commonly asked
questions, information on software upgrades and other topics is available
electronically through the following:

■ Adaptec World Wide Web (WWW) site at http://www.adaptec.com.

■ File Transfer Protocol (FTP) server at ftp.adaptec.com.

■ Adaptec USA Bulletin Board Service (BBS) at 408-945-7727; supports up to 28,8
bps (bits per second), 8 data bits, 1 stop bit, no parity. No product literature is
available on the Adaptec BBS.

■ Interactive Fax System at 303-684-3400; available 24 hours a day, 7 days a week

ASUS Contact Information
ASUS may be contacted at http://www.asus.com.tw or through any of the means
indicated in your motherboard manual.
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Technical and Product Support

■ For technical support and information about many of Adaptec’s electronic 
support services, call 800-959-7274 or 408-945-2550, 24 hours a day, 7 days a week.

■ To speak with a product support representative, call 408-934-7274, M–F, 6:00 A.M. 
to 5:00 P.M., Pacific Time. After hours, on weekends, and on holidays, product 
support is also available for a fee at 800-416-8066.

Sales and Ordering Information

■ For sales information, call 800-959-7274 or 408-945-2550, M–F, 6:00 A.M. to 5:00 
P.M., Pacific Time.

■ To order Adaptec software and cables, call 800-442-7274 or 408-957-7274, 
M–F, 6:00 A.M. to 5:00 P.M., Pacific Time.

■ To request additional documentation for Adaptec products, call 800-934-2766 or 
510-732-3829, M–F, 6:00 A.M. to 5:00 P.M., Pacific Time.

Federal Communications Commission Radio Frequency Interference Statement
WARNING: Changes or modifications to this unit not expressly approved by the party responsi-
ble for compliance could void the user’s authority to operate the equipment.

This equipment has been tested and found to comply with the limits for a Class B digital device, 
pursuant to Part 15 of the FCC rules. These limits are designed to provide reasonable protection 
against harmful interference in a residential installation. This equipment generates, uses, and can 
radiate radio frequency energy, and if not installed and used in accordance with the instruction 
manual, may cause harmful interference to radio communications. However, there is no guaran-
tee that interference will not occur in a particular installation. However, if this equipment does 
cause interference to radio or television equipment reception, which can be determined by turn-
ing the equipment off and on, the user is encouraged to try to correct the interference by one or 
more of the following measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between equipment and receiver.

• Connect the equipment to an outlet on a circuit different from that to which the receiver is con-
nected.

• Consult the dealer or an experienced radio/television technician for help.

Use a shielded and properly grounded I/O cable and power cable to ensure compliance of this 
unit to the specified limits of the rules.

This device complies with part 15 of the FCC rules. Operation is subject to the following two 
conditions: (1) this device may not cause harmful interference and (2) this device must accept any 
interference received, including interference that may cause undesired operation.

Canadian Compliance Statement
This Class B digital apparatus meets all requirements of the Canadian Interference-Causing 
Equipment Regulations.

Cet appareil numérique de la classe B respecte toutes les exigences du Règlement sur le matérial 
brouilleur du Canada.
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1▼  ▼  ▼  ▼
Introduction
The Adaptec® 7800 Family Manager Set v3.x is a set of software 
drivers and other files that enable your Adaptec 7800 Family host 
adapter to communicate with your computer. The Adaptec 7800 
Family Manager Set contains drivers for the following operating 
systems:

■ Microsoft Windows NT®

■ Microsoft Windows 95

■ Novell NetWare

■ IBM OS/2

■ SCO UNIX

■ SCO UnixWare

The remainder of this chapter includes a table that lists all Adaptec 
host adapters that make up the Adaptec 7800 Family, as well as the 
minimum requirements needed to install the software.

The remaining chapters are organized by operating system. Each 
chapter provides instructions on how to install the driver at the 
same time you install your operating system. If your operating 
system is already installed, instructions on updating or installing the 
driver are also included. If you have problems installing and using 
the driver, refer to the Troubleshooting sections, included at the end of 
each chapter.
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Adaptec 7800 Family Manager
Device Drivers
The 7800 Family Manager Set has two driver files for each operating 
system; one for Ultra SCSI and earlier devices and one for Ultra2 
SCSI devices. This manual refers to both the Ultra SCSI and Ultra2 
SCSI drivers when describing installation. Refer to the table below 
for a list of files for the drivers provided on your installation diskette 
or CD ROM. Use the columns in the table to determine the correct 
driver for your SCSI device.

For information on how to install the driver for your SCSI Adapter, 
refer to the section of this manual describing your specific operating 
system.

Operating System UltraSCSI Driver Ultra2 SCSI Driver

Windows NT aic78xx.sys aic78u2.sys

Windows95 aic78xx.mpd aic78u2.mpd

NetWare aic7870.dsk aic78u2.ham

OS2 aic7870.add aic78u2.add

SCO UNIX alad or alad325 blad or blad325

SCO UnixWare adsl20 or adsl adsb20 or adsb
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Introduction
Adaptec 7800 Family Host Adapters
The following Adaptec PCI-to-SCSI host adapters are collectively 
referred to as the Adaptec 7800 Family host adapters:

Host Adapter Description

AVA-2902I PCI-to-Fast SCSI (non-bootable, internal)

AVA-2902E PCI-to-Fast SCSI (non-bootable, external)

AVA-2904 PCI-to-Fast SCSI (non-bootable)

AHA-2910 PCI-to-Fast SCSI (non-bootable) 

AHA-2930 PCI-to-Fast SCSI 

AHA-2940 PCI-to-Fast SCSI 

AHA-2940W PCI-to-Fast and Wide SCSI 

AHA-2940AU PCI-to-Ultra SCSI 

AHA-2940U PCI-to-Ultra SCSI 

AHA-2940UW PCI-to-Wide Ultra SCSI 

AHA-2940U2W PCI-to-Ultra2 Wide Single-ended SCSI 

AHA-2940U Dual MultiChannel PCI-to-Ultra SCSI with Dual 
External Connectors

AHA-2940UW Dual MultiChannel PCI-to-Wide Ultra SCSI with 
Dual External Connectors

AHA-2944W PCI-to-Fast and Wide Differential SCSI

AHA-2944UW PCI-to-Wide Ultra Differential SCSI 

AHA-3940 MultiChannel PCI-to-Fast SCSI

AHA-3940W MultiChannel PCI-to-Fast and Wide SCSI

AHA-3940U MultiChannel PCI-to-Ultra SCSI 

AHA-3940UW MultiChannel PCI-to-Wide Ultra SCSI 

AHA-3940UWD MultiChannel PCI-to-Wide Ultra SCSI with 
Dual External Connectors

AHA-3940AU MultiChannel PCI-to-Ultra SCSI

AHA-3940AUW MultiChannel PCI-to-Wide Ultra SCSI

AHA-3940AUWD MultiChannel PCI-to-Wide Ultra SCSI with 
Dual External Connectors

AHA-3944W MultiChannel PCI-to-Fast and Wide 
Differential SCSI
1-3



Adaptec 7800 Family Manager
AHA-3944UWD MultiChannel PCI-to-Wide Ultra Differential 
SCSI with Dual External Connectors

AHA-3944AUWD MultiChannel PCI-to-Wide Ultra Differential 
SCSI with Dual External Connectors

AHA-4944W Quad Channel PCI-to-Fast and Wide 
Differential SCSI 

AHA-4944UW Quad Channel PCI-to-Ultra Wide Differential 
SCSI

AIC-7850 Single-chip PCI-to-Fast SCSI 

AIC-7855 Single-chip PCI-to-Fast SCSI

AIC-7856 Single-chip PCI-to-Fast SCSI

AIC-7860 Single-chip PCI-to-Ultra SCSI

AIC-7870 Single-chip PCI-to-Fast and Wide SCSI 

AIC-7880 Single-chip PCI-to-Wide Ultra SCSI 

AIC-7890 Single-chip PCI-to-Ultra2 SCSI (32 bit)

AIC-7891 Single-chip PCI-to-Ultra2 SCSI (64 bit)

AIC-7895 Single-chip PCI-to-MultiChannel Wide Ultra 
SCSI 

AIC-7896 Single-chip PCI-to-MultiChannel Ultra2 SCSI 
(32 bit)

AIC-7897 Single-chip PCI-to-MultiChannel Ultra2 SCSI 
(32 bit)

Host Adapter Description
1-4



Introduction
Requirements
The following are the minimum and recommended requirements 
needed to install the Adaptec 7800 Family Manager Set:

■ A PCI computer, with an installed and configured Adaptec 
7800 Family host adapter(s). 

■ An installed primary (boot) floppy diskette drive. The drive 
must be able to read your operating system diskettes. A 
3.5-inch (1.44 MByte) floppy diskette drive is required. 

■ The diskettes included with your Adaptec 7800 Family 
Manager Set.

■ Optional—an installed and configured CD-ROM drive for 
installing your operating system from CD-ROM.

■ The distribution software and documentation included with 
your operating system.

■ The User’s Guide for your host adapter.

❒
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2▼  ▼  ▼  ▼
Microsoft Windows NT 
Installation

This chapter explains how to install the Adaptec 7800 Family 
Manager Set aic78xx.sys and aic78u2.sys drivers for 
Windows® NT. The aic78xx.sys driver supports all Adaptec 7800 
Family Ultra SCSI (and earlier) host adapters, and the aic78u2.sys 
driver supports all Ultra2 SCSI adapters. Refer to the list on 
page 1-3.

If you are performing a first time Windows NT installation, see 
Installing the Driver When Installing Windows NT on page 2-2. If 
Windows NT is already installed in your system, see Installing the 
Driver When Windows NT is Already Installed on page 2-5.
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Adaptec 7800 Family Manager
Installing the Driver When Installing Windows NT
A version of the aic78xx.sys driver(Ultra SCSI) driver is embedded 
(included) in the Windows NT 3.5x and 4.0 installation disks (or CD-
ROM). During a normal Windows NT installation, the 7800 Family 
host adapter is detected in your system and the embedded driver is 
automatically installed. 

Note: If you are booting from a 7800 Family host adapter 
and you are unable to install the embedded aic78xx.sys 
driver by performing a Windows NT installation, follow the 
instructions for completing a fresh Windows NT installation.

The aic78u2.sys driver (Ultra2 SCSI) is not embedded on the 
Windows NT 3.5x and 4.0 installation disks (or CD-ROM) and must 
be installed after Windows NT has been installed. When completing 
the Windows NT installation, you can update the driver by 
following the instructions in Installing the Driver When Windows NT 
is Already Installed on page 2-5.

Completing a Fresh Windows NT 3.5x Installation
1 If you choose to install Windows NT from a floppy drive, 

locate the Windows NT Setup Disk 1 for Floppy Installation.

If you are installing from a CD-ROM drive, locate the 
Windows NT Setup Disk 1 for CD-ROM Installation.

2 Insert the diskette into drive A (not drive B) and turn ON your 
computer. When prompted, insert Windows NT Disk 2.

3 From the Welcome to Setup Screen, press Enter to set up 
Windows NT.

4 When prompted, select Custom setup.

Note: If you are installing an Ultra2 SCSI host adapter 
such as the AHA-2940U2W, you cannot select Express 
setup, because the aic78u2.sys driver is not 
embedded. Selecting Express setup loads the 
embedded driver aic78xx.sys included with Windows 
NT which is for Ultra SCSI adapters only. 
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Microsoft Windows NT Installation
5 Press S to skip mass storage device detection. This allows you 
to manually select the driver for your host adapter.

6 Since mass storage device detection was skipped in the 
previous step, Windows NT Setup displays none in the list of 
recognized devices. Press S to configure additional SCSI 
adapters.

7 From the list of additional SCSI adapters, expand the list, select 
Other, and press Enter (requires disk provided by a hardware 
manufacturer).

8 Insert the Adaptec 7800 Family Manager Set diskette for 
Windows NT into drive A and press Enter.

The screen displays the adapter drivers supported on the 
diskette. For Windows NT 3.5x, the following is displayed:

Adaptec AHA-290x/291x/294x/4944/AIC-78xx PCI SCSI 
Controller (NT 3.5x) 

or

Adaptec AHA-294xu2/AIC-7890/91 PCI Ultra2 SCSI Controller 
(NT 3.5x)

9 Highlight the driver and press Enter. 

10 To add other host adapters that are not a part of the 7800 
Family, do so at this time by repeat from step 7 for each 
additional adapter and insert the appropriate driver disk. The 
Adaptec 7800 Family host adapters use the same driver; it is 
not necessary to install the driver again.

11 Press Enter to continue with the Windows NT operating 
system setup. Follow the instructions given onscreen and in 
the Windows NT installation documentation.
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Adaptec 7800 Family Manager
Completing a Fresh Windows NT 4.0 Installation
1 Start your system with the Windows NT Boot Diskette in the 

floppy drive.

2 When prompted, insert diskette #2 in your floppy drive. After 
a few moments you will see a blue screen. To setup Windows 
NT now, press Enter.

3 Press S to skip auto-detection of your SCSI host adapter.

4 Press S again to specify an additional device.

5 Press Enter to select Others; insert the 7800 Family Manager 
Set diskette for Windows NT in your floppy drive.

6 Select from the following drivers:

Adaptec AHA-290x/291x/294x/394x/4944/AIC-78xx PCI SCSI 
Controller (NT 4.0) 

or

Adaptec AHA-294xu2/AIC-7890/91 PCI Ultra2 SCSI Controller 
(NT 4.0)

7 Highlight a driver and press Enter.

8 To add other host adapters that are not part of the 7800 Family, 
press S and repeat from Step 4 for each additional adapter and 
insert the appropriate driver disk. The Adaptec 7800 Family 
host adapters use the same driver; it is not necessary to install 
the driver again.

9 Press Enter to continue with the Windows NT operating 
system setup. Follow the instructions onscreen and in the 
Windows NT documentation to complete the installation.
2-4



Microsoft Windows NT Installation
Installing the Driver When Windows NT is 
Already Installed
To update or install the aic78xx.sys or aic78u2.sys driver if 
Windows NT is already installed, follow the instructions below for 
the version of Windows NT you are installing.

Updating Windows NT 3.5x
1 Select and start the Windows NT Setup program. (Its icon is 

usually found in the Main program group.) There is a brief 
pause while Windows NT Setup scans your hardware 
configuration.

2 Select the Options pull-down menu and then select 
Add/Remove SCSI Adapters. The SCSI Adapter setup 
program displays a list of all host adapters currently installed.

3 Click the Add button to add another host adapter type to the 
list. A list of additional SCSI adapters appears.

4 Expand the list of additional SCSI adapters; select Other and 
press Enter. (Requires disk provided by the hardware 
manufacturer.)

5 Insert the Adaptec 7800 Family Manager Set diskette for 
Windows NT into drive A; enter one of the following paths 
to the installation files and then click OK.

a:\winnt\3_5)

The screen displays the adapter drivers supported on the 
diskette:

Adaptec AHA-290x/291x/294x/4944/AIC-78xx PCI SCSI 
Controller (NT 3.5x) 

Adaptec AHA-294xu2/AIC-7890/91 PCI Ultra2 SCSI Controller 
(NT 3.5x)

6 Highlight a driver, then click OK. The driver is added to the 
list of SCSI adapters.

7 Select the driver from the list of SCSI adapters and click Install.

At this point, Windows NT Setup checks to see if the specified 
driver has already been copied to the system disk.
2-5



Adaptec 7800 Family Manager
8 If the following message appears, click New to replace the 
existing driver and skip to Step 10.

The driver(s) for this SCSI Adapter are already on the 
system. Do you want to use the currently installed driver(s) 
or install new one(s).

If the following message appears, continue with Step 9.

Please enter the full path to the Windows NT SCSI Adapter 
files.

9 Change the path to the a:\winnt\3_5 directory, then click 
Continue.

The device driver is copied to your system disk and the 
Windows NT configuration is updated so that the new device 
driver loads when Windows NT reboots.

10 When the installation is complete, Windows NT Setup again 
displays a list of currently installed host adapter types. Verify 
that the new host adapter appears on the list. The text string 
should look similar to: 

Adaptec AHA-290x/291x/294x/4944/AIC-78xx PCI SCSI 
Controller (NT 3.5x) 

or

Adaptec AHA-294xu2/AIC-7890/91 PCI Ultra2 SCSI Controller 
(NT 3.5x)

11 Add other types of host adapters if necessary (see step 4 on 
page 2-5), or click Close to exit the SCSI adapters portion of 
Windows NT Setup, and then close the program.

12 When you see this message, click OK to exit:

The changes you have made will not take effect until the 
computer is restarted

If this message does not appear, no changes have been made to 
the Windows NT system configuration.

13 Restart your computer and Windows NT. It is possible that 
some drive letter assignments may change from the previous 
configuration.
2-6



Microsoft Windows NT Installation
Updating Windows NT 4.0
1 Start Windows NT.

2 Click the Start button on the Windows NT task bar, and then 
point to Settings.

3 Click the Control Panel.

4 Double-click the SCSI Adapters icon.

5 Click the Drivers tab, and then click the Add button.

6 In the Install Driver window, click the Have Disk button.

7 Insert the 7800 Family Manager Set diskette for Windows NT 
into drive A.

8 From the Copy Manufacturer’s File From text box, type 
a:\winnt\4.0, and click OK.

9 In the Install Driver window, Click OK.

10 Click the New button when asked if you want to use the 
currently installed driver(s) or install new one(s).

11 Type a:\winnt\4_0 again, and click Continue. The driver is now 
installed.

12 You must restart your computer for the changes to take effect. 
Click Yes to restart your computer. Click No to return to the 
SCSI Adapters window.
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Adaptec 7800 Family Manager
Using Advanced Configurable Parameters
Advanced users may use software parameters to alter the 
configuration of the Windows NT device drivers supplied by 
Adaptec. All Windows NT configuration information is stored in a 
data structure called the Registry. You can edit this information 
through a tool called the Registry Editor.

Caution: Do not edit your registry unless it is absolutely 
necessary. If there is an error in your registry, your computer 
may become nonfunctional.

Using Windows NT SCSI Parameters
Follow the instructions below to enter the registry values that affect 
how the Windows NT SCSI manager interprets the generic 
configuration information of SCSI device drivers. All SCSI host 
adapters installed in your system are affected by the values you enter 
here. A list of valid values follows.

Note: The following value keys are case-sensitive and must 
be entered exactly as shown.

■ DisableTaggedQueuing—A nonzero value indicates that the 
SCSI host adapter disables tagged queueing for SCSI devices. 
The data type for this value is REG_SZ.

■ DisableSynchronousTransfers—A nonzero value indicates 
that the SCSI host adapter is not to initiate synchronous 
negotiations (but it may still accept negotiations initiated by a 
SCSI target). The data type for this value is REG_SZ.

■ DisableDisconnects—A nonzero value indicates that targets 
are not permitted to disconnect during the execution of a SCSI 
command. The data type for this value is REG_DWORD.

■ MaximumLogicalUnit—This can limit the scan for connected 
devices on the SCSI bus. Valid values are 1 to 8. If 1 is specified, 
the Windows NT SCSI manager assumes that no SCSI targets 
support LUNs other than 0. Otherwise, LUNs from 0 to 8 are 
scanned during system initialization. The data type for this 
value is REG_DWORD.

!
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Microsoft Windows NT Installation
■ Maximum SGList— Specifies the maximum number of 
scatter-gather elements. Valid values are 17-255. The data type 
for this value is REG_DWORD.

To enter Windows NT parameters, follow these steps:

1 Select Run from the File menu (Windows NT 3.5x), or Run 
from the Start button (Windows NT 4.0).

2 Type regedt32 and press Enter.

3 Open the registry list to the following location:

\HKEY_LOCAL_MACHINE\System\CurrentControlSet\
Services\aic78xx\Parameters\Device

or

\HKEY_LOCAL_MACHINE\System\CurrentControlSet\
Services\aic78u2\Parameters\Device

If the \Parameters\Device keys already exist, skip to step 8 
below to begin entering values. If the keys do not yet exist, you 
will need to create them by continuing with step 4.

4 Click on the aic78xx or aic78u2 key.

5 Select Add Key from the Edit menu; Type Parameters in the 
Key Name edit box. Leave the Class edit box blank.

6 Click on the Parameters key.

7 Select Add Key from the Edit menu; Type Device in the Key 
Name edit box. Leave the Class edit box blank.

To specify a certain host adapter, append Device with the 
number of the host adapter. For example, type Device0 for the 
first host adapter, Device1 for the second, etc. If you omit the 
host adapter number, the configuration information applies to 
all 7800 Family host adapters.

8 Click on the Device key.

9 Select Add Value from the Edit menu. In the Value Name edit 
box, enter one of the valid parameter values. Make sure to 
enter the appropriate Data Type for the value. To enter 
additional values, repeat steps 8-9. 
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Adaptec 7800 Family Manager
Note: Changes made with the Registry Editor do not take 
effect until you shut down and then restart your system.

Using Driver-specific Parameters
To use the Registry Editor to enter aic78xx.sys or aic78u2.sys 
driver-specific parameters that affect the configuration information 
for Adaptec SCSI PCI device drivers, follow the instructions below. 
A list of valid parameters follows.

Note: The following parameters are case-sensitive and must 
be entered exactly as shown. When entering multiple 
parameters, each parameter must be separated by a space.

■ /INSTRUMENTATION—enables recording of I/O statistics 
and errors. If this option is not specified, instrumentation 
defaults to disabled. The data type for this value is REG_SZ.

■ /INSTR_ERRLOG_Z=nnn—sets the maximum number of 
error log entries, if /INSTRUMENTATION is enabled. If a 
number is not specified, the maximum number or error log 
entries defaults to 32. Valid values are 0-128. The data type for 
this value is REG_SZ.

■ /MAXTAGS=nnn—specifies the tagged command queue 
depth. If a number is not specified, the tagged queue depth 
defaults to 128. Valid values are 1-255. The data type for this 
value is REG_SZ.
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Microsoft Windows NT Installation
To enter driver-specific parameters, follow these steps:

1 Select Run from the File menu (Windows NT 3.5x), or Run 
from the Start button (Windows NT 4.0).

2 Type regedt32 and press Enter.

3 Open the registry list to the following location:

\HKEY_LOCAL_MACHINE\System\CurrentControlSet\
Services\aic78xx\Parameters\Device\DriverParameters

or

\HKEY_LOCAL_MACHINE\System\CurrentControlSet\
Services\aic78u2\Parameters\Device\DriverParameters

If the \Parameters\Device\DriverParameters keys already exist, 
skip to step 10 below to begin entering parameters. If the keys 
do not yet exist, you will need to create them by continuing 
with step 4.

4 Click on the aic78xx or aic78u2 key.

5 Select Add Key from the Edit menu; Type Parameters in the 
Key Name edit box. Leave the Class edit box blank.

6 Click on the Parameters key.

7 Select Add Key from the Edit menu; Type Device in the Key 
Name edit box. Leave the Class edit box blank.

To specify a certain host adapter, append Device with the 
number of the host adapter. For example, type Device0 for the 
first host adapter, Device1 for the second, etc. If you omit the 
host adapter number, the configuration information applies to 
all 7800 Family host adapters.

8 Click on the Device key.

9 Select Add Value from the Edit menu; type DriverParameters 
in the Key Name edit box. Enter REG_SZ as the Data Type and 
press Enter.

10 A String Editor text box appears. Enter valid parameters in the 
text box. When entering multiple parameters, each parameter 
must be separated by a space.
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Note: Changes made with the Registry Editor do not take 
effect until you shut down and then restart your system.

Using Windows NT and the Host Adapter
This section contains useful information on using Windows NT and 
your host adapter.

Removing a Host Adapter
Removing a host adapter can be as simple as physically removing it 
from the slot when your computer is shut down. Windows NT boots 
and functions properly in this configuration, but a warning message 
is generated every time you boot Windows NT.

Caution: If you have removed a host adapter but still have 
other host adapters of the same type installed in your 
computer, do not use Windows NT Setup to remove the 
device driver.

To eliminate the warning message, you must update the Windows 
NT software configuration, as described below:

Removing a Host Adapter in Windows NT 3.5x

1 Start the Windows NT Setup program. There is a brief pause 
while Windows NT Setup scans your hardware configuration.

2 Select the Options pull-down menu and then select 
Add/Remove SCSI Adapters. The SCSI Adapter setup 
program displays a list of all host adapters currently installed.

3 Select the host adapter you want to remove and click the 
Remove button. When the Windows NT Setup program asks 
you for confirmation, click OK.

Because SCSI device drivers are loaded during system bootup 
and because they may be needed to load Windows NT itself, a 
screen may appear warning you that Windows NT may not 
start if you remove the SCSI adapter.

!
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4 If you are sure you are removing the correct host adapter type, 
click OK.

5 Return to Step 3 to remove driver support for other types of 
host adapters, or click Close to exit the SCSI adapters portion 
of Windows NT Setup.

6 Close the Windows NT Setup program. When the following 
message appears, click OK to exit:

The changes you have made will not take effect until the 
computer is restarted.

If this message does not appear, no changes have been made to 
the Windows NT system configuration.

7 Restart the computer.

Note: Windows NT Setup does not delete the device driver 
from your system disk; it only updates Windows NT 
software configuration information so that the device driver 
is no longer loaded during system bootup. 
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Removing a Host Adapter in Windows NT 4.0

1 From the Control Panel, double-click the SCSI Adapters icon.

2 Click the Drivers tab.

3 Select the driver you are planning to remove. The driver 
appears as one of the following:

For Ultra SCSI:

Adaptec AHA-294X/AHA-394x/AHA-4944 or AIC-78xx PCI 
SCSI Controller (NT 4.0)

or

Adaptec AHA-294x/AHA-394x or AIC-78xx PCI SCSI 
Controller (NT 4.0)

or

Adaptec AHA-294x/AHA-394x or AIC-78xx PCI SCSI 
Controller

For Ultra2 SCSI

Adaptec AHA-294Xu2/AIC-7890\91 PCI Ultra2 SCSI Controller 
(NT 4.0)

4 Click the Remove button.

5 If you are sure you are removing the correct host adapter type, 
click Yes.

6 Click Yes to restart the computer and initialize changes. Click 
No to return to the SCSI Adapters window.

Note: Windows NT Setup does not delete the device driver 
from your system disk; it only updates Windows NT 
software configuration information so that the device driver 
is no longer loaded during system bootup. 
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Swapping a Host Adapter
Swapping a 7800 Family host adapter for a non-7800 Family host 
adapter is similar to the procedure for adding a host adapter. The 
important distinction is that you make all software configuration 
changes while Windows NT is running and before you make the 
hardware changes.

Note: If you do not install the driver that comes with the 
new host adapter, it may result in a Windows NT boot 
failure.

To swap adapters, follow these steps:

1 Install the driver for the 7800 Family host adapter by following 
the steps in Installing the Driver When Windows NT is Already 
Installed on page 2-5.

It is not essential to remove the device driver for the host 
adapter you are replacing. Windows NT dynamically detects 
the absence or presence of host adapter hardware, and no 
problems should arise if you leave the existing device driver 
installed. You may remove the device driver later, after you 
have successfully rebooted Windows NT. However, if you 
leave the driver installed, the system alerts you with an error 
message of the extra device driver every time you boot. See 
Removing a Host Adapter on page 2-12.

2 Once the new device driver is installed, shut down Windows 
NT and replace the existing host adapter with the 7800 Family 
host adapter. 

3 Restart your computer and Windows NT. It is possible that 
some drive letter assignments may change from the previous 
configuration.
2-15



Adaptec 7800 Family Manager
Troubleshooting

Problems and Solutions

I made changes to the host adapter configuration and Windows NT no longer boots!
The boot manager for Windows NT contains recovery logic to allow 
you to return to the last known good configuration. If you have 
changed your host adapter configuration and Windows NT no 
longer boots, follow these steps to recover:

1 Undo any hardware changes you have made to the computer 
since it was last operational.

2 Reboot the computer. Watch the display carefully during 
bootup. If the following message appears, press the Spacebar 
and follow the instructions on the screen to continue booting 
with the last known good configuration:

Press spacebar NOW to invoke the Last Known Good menu

3 Once your computer is operational again, check all of the 
hardware and software configuration changes you want to 
make. Look specifically for conflicts with parts of the existing 
system configuration that are not being changed.

Error Codes
Error codes generated by the aic78xx.sys or aic78u2.sys driver can 
be viewed by opening the Windows NT Event Viewer error logs.

To view events generated by the driver, follow these steps:

1 Double-click the Event Viewer icon in the Administrative 
Tools program group.

Error codes generated by the driver show up as Event ID 11. 
Error codes generated by the SCSIPort show up as Event ID 9.

2 To view event details, select System from the Log menu. 
Double-click the aic78xx.sys or aic78u2.sys driver event that 
has an Event ID of 11. (There may be none or multiple driver 
events.)

The top portion of the Event Detail dialog box displays 
information such as the time that the event was generated, the 
computer on which the event occurred (in case of remote 
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monitoring) and the description of the event. The Data section 
of the Event Details dialog box displays the error codes 
generated.

3 Click the Words radio button.

In the Data section of the dialog box, the entry in the second 
row and second column (to the right of the 0010: entry) lists the 
error code generated by the driver. The common error codes 
for the driver are described below.

Note: The entry in the third row of the last column 
identifies the SCSI ID of the device originating the 
error.

aic78xx.sys or aic78u2.sys Error Codes
The following error codes are listed sequentially according to the 
last three digits of the code. For example, [xxxxx010], [xxxxx011], 
[xxxxx012], etc.

Note: When reporting problems to Customer Support, be 
sure to include the complete error code in your problem 
description.

[xxxxx004]
[xxxxx005]
[xxxxx006]
Command completed with error. A request issued to a target device 
completed with indication that there is an error. In most cases, the 
error is recovered and normal operations continues.

[xxxxx010]
Error issuing command. An error has occurred while the driver was 
setting up its internal data structures.

[xxxxx011]
Error issuing command. The requested command is not supported 
by this driver.
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[xxxxx012]
[xxxxxx99]
Error issuing command. The driver does not recognize the target 
device.

[xxxxx021]
Device protocol error. An unexpected event occurred during data 
transfer between the adapter and target device. Normally, this 
indicates a faulty or noncompliant target device.

[xxxxx022]
Adapter or target device protocol error. The adapter or target device 
has broken the communication protocol. A badly behaving device 
could be cause this message to appear. Normally this is not a serious 
problem. If you get this message frequently over a short period of 
time, it could indicate that the device or system is malfunctioning. 
Unplug or power down unused devices to see if the problem 
persists.

[xxxxx023]
Target device parity error. The driver has detected a parity error by 
the target device.

[xxxxx024]
Data overrun or underrun. The adapter was given more or less data 
than the expected amount of data.

[xxxxx031]
Target device queue full. The target device internal buffer is full.

[xxxxx032]
Target device busy. The target device reports a busy status. Another 
program may already be using this device.

[xxxxx050]
[xxxxxx9A]
Host adapter failure. Your host adapter may not be properly 
installed or is defective. Try re-seating the adapter in the PCI slot, or 
try installing it a different PCI slot.
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[xxxxx081]
[xxxxxx8A]
[xxxxxx83]
Adapter initialization failure. An error has occurred while the driver 
was setting up its internal data structures. Verify that your adapter is 
supported by this version of the driver.

[xxxxx089]
Unable to allocate memory. This indicates that there may be a 
problem with the amount of memory installed in your system. 
Verify that your system has at least the minimum amount of 
memory required by your operating system.

[xxxxx096]
Adapter hardware initialization failure—possible resource conflict. 
The driver has attempted to initialize the adapter hardware but 
failed. This might suggest that the adapter resources (e.g., IRQ) 
conflict with another board installed in your system.

[xxxxx097]
Unable to allocate memory. This indicates that there may be a 
problem with the amount of memory installed in your system. 
Verify that your system has at least the minimum amount of 
memory required by your operating system.

[xxxxx0af]
Unable to de-allocate memory that was allocated for a target device. 
Normally, this is not a serious problem, unless you get this message 
frequently over a short period of time. The memory can be 
reclaimed by rebooting the system.

[xxxxx0ce]
Scatter Gather Limit exceeded. An I/O request packet from the 
system contained a Scatter Gather element list that contained more 
elements than are supported by the miniport. Scatter Gather is a list 
of data segments that define the entire data transfer. Scatter Gather 
is a means to improve total data throughput. This error might be 
caused by a component external to the miniport driver, such as the 
operating system or an ASPI application.
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[xxxxxd4]
Adapter hardware failure - adapter reset. The host adapter 
hardware failed and the miniport has to reset the hardware.

[xxxxx0d6]
Internal driver error. An error has occurred while the driver was 
setting up its internal data structures. Try installing the most up-to-
date version of the driver available from the Adaptec Web site or 
BBS.

❒

2-20



3▼  ▼  ▼  ▼
Microsoft Windows 95 
Installation
This chapter explains how to install the Adaptec 7800 Family 
Manager Set aic78xx.mpd and aic78u2.mpd drivers for 
Windows® 95. The aic78xx.mpd driver supports all Adaptec 7800 
Family UltraSCSI (and earlier) host adapters, and the aic78u2.mpd 
driver supports all Ultra2 SCSI adapters. Refer to the list on 
page 1-3.

If you are performing a first time Windows 95 installation, see 
Installing the Driver When Installing Windows 95 on page 3-2. If 
Windows 95 is already installed in your system, see Installing the 
Driver When Windows 95 is Already Installed on page 3-2.

Note: When Windows 95 starts, if a New Hardware Found 
dialog is displayed after your 7800 Family Manager Set host 
adapter has been installed, you must select the Driver from 
Disk Provided by Hardware Manufacturer option. Insert your 
Adaptec 7800 Family Manager Set v. 3.00 diskette into the 
floppy drive and type a:\win95 as the path. Then, follow the 
on screen instructions.
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Installing the Driver When Installing Windows 95
A version of the aic78xx.mpd (Ultra SCSI) driver is embedded 
(included) in the Windows 95 installation CD-ROM. During a normal 
Windows 95 installation, the 7800 Family host adapter (Ultra SCSI or 
earlier) is detected in your system and the embedded aic78xx.mpd 
driver is automatically installed.

Note: If the Windows 95 installation cannot detect the 7800 
Family host adapter(Ultra SCSI or earlier) installed in your 
computer, or you are installing the aic78u2.mpd driver for 
an Ultra2 SCSI host adapter, you must install the driver 
manually after Windows 95 is complete. Follow the 
procedures in the section, Installing the Driver When Windows 
95 is Already Installed, below

Installing the Driver When Windows 95 is 
Already Installed
To update or install the aic78xx.mpd or aic78u2.mpd if Windows 95 
is already installed, follow these instructions:

Note: All Adaptec 7800 Family Ultra SCSI (and earlier) host 
adapters use the aic78xx.mpd driver. Ultra2 SCSI adapters 
use the aic78u2.mpd driver. Once the correct driver is 
updated, it is not necessary to update it again for each 7800 
Family host adapter installed in your system.

1 Start Windows 95.

2 Click the Start button on the Windows 95 task bar, and then 
point to Settings.

3 Click Control Panel.

4 Double-click the System icon.

5 On the Device Manager tab, click the plus sign (+) next to the 
SCSI controller icon.
3-2



Microsoft Windows 95 Installation
Note: If Windows 95 cannot determine the type of host 
adapter installed in your computer, a yellow question 
mark labelled Other devices appears instead of the SCSI 
controller icon. To continue, click the plus sign (+) next 
to the question mark; a yellow question mark labelled 
PCI SCSI Bus Controller then appears.

6 Double-click the 7800 Family host adapter you wish to update, 
or if a yellow question mark labelled PCI SCSI Bus Controller is 
displayed, double-click the question mark.

7 Insert the Adaptec 7800 Family Manager Set v.3.00 diskette 
into drive A.

8 Select the Drives tab

Note: If the version of Windows 95 you are using displays an 
Update Drivers button instead of a Change Driver button, 
follow the procedures in the section Updating the Driver for 
Windows 95 (Version OSR 2) on page 3-4.

9 Click Change Driver. If you are prompted to select the 
hardware type, select SCSI Controller.

10 Click the Have Disk button and enter a:\win95 as the path.

11 Click OK.

12 Select the 7800 Family host adapter, and click OK.

13 Click OK. The driver is copied and scanned.

14 You must restart your computer for the changes to take effect. 
Click Yes to restart your computer. Click No to return to the 
system properties window.
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Updating the Driver for Windows 95 (Version 
OSR 2)
This section covers the remaining steps for updating the drives on 
Windows 95, OSR 2.

1 Follow steps 1 through 7 in the previous section, Installing the 
Driver When Windows 95 is Already Installed.

2 Click Update Drivers.

3 In the Update Device Driver Wizard, select Yes, then click 
Next.

4 Under Location type a:\win95, then click OK.

5 Click Finish.

6 The message Please insert the disk labeled ‘7800 Family Manager 
Set v.3.00 Installation Disk’ appears dialog box. Click OK.

7 In the Copying Files dialog box, a message stating that ‘The file 
AIC78XX.MPD or AIC78U2.MPD on 7800 Family Manager Set 
v3.00 installation disk could not be found...’ appears. Type 
a:\win95 and click OK to install the driver.

8 Click Yes to restart you computer to update the changes. To 
return to the System Properties window, click No.

Note: If you wish to re-update the driver again, you must 
select No at step 3 above, then click Next and follow the 
onscreen instructions to re-update.
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Troubleshooting

Problems and Solutions

What is a miniport driver, and how do I make sure that the miniport driver for my host 
adapter is installed correctly?
Miniport drivers are 32-bit protected mode device drivers used by 
Windows 95 to control host adapters and devices. Windows 95 
includes a set of miniport drivers for various SCSI host adapters.

If your 7800 Family host adapter is already installed, the adapter’s 
miniport driver is automatically installed and configured during 
Windows 95 installation. Follow the instructions listed in Installing 
the Driver When Windows 95 is Already Installed on page 3-2 to ensure 
that the miniport driver is updated.

To make sure the driver is installed correctly in systems running 
Windows 95, open the Control Panel, double-click on System, and 
click the Device Manager tab. Then double-click the SCSI 
Controllers icon; you should see the model name of the SCSI host 
adapter(s) installed in your system.

What if there is no SCSI Controllers icon under Device Manager, or the model name of 
the host adapter does not appear under Device Manager?
If the SCSI Controllers icon or your host adapter’s model name do 
not appear in the Device Manager, follow these steps:

1 Open Control Panel and double-click the Add New Hardware 
icon. Let Windows search for the host adapter by selecting Yes 
on the second screen of the Add New Hardware Wizard.

2 If Windows does not detect the adapter, run the Add New 
Hardware Wizard again. This time, select No on the second 
screen of the wizard, then select SCSI Controllers on the next 
screen.

3 Insert the 7800 Family Manager Set diskette for Windows 95 
into your floppy drive.

4 Select the model of your 7800 Family host adapter, and then 
click the Have Disk button.

5 Enter a:\win95 or b:\win95 as the location to copy the file from.

6 Click OK. The driver is copied and your system is updated.
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7 You must restart your computer for the changes to take effect.

What if a yellow exclamation mark or a red X appears in Device Manager in front of my 
host adapter.
This means there is some kind of resource problem. First, see if the 
names of any host adapters appear that are not actually installed in 
your computer. If so, select the name and click Remove.

If a red X appears in front of your host adapter name, remove all the 
host adapter references under SCSI Controllers and run Add New 
Hardware, as described in the previous question/answer. 

If a yellow exclamation point appears in front of your host adapter 
name, the resources that the driver uses probably do not match the 
resources used by the hardware. Double-click the host adapter 
name, then click on the Resource tab. Deselect the Use Automatic 
Settings box and edit the resources (Interrupt Request, Direct 
Memory Access, etc.) so they match those used by the host adapter. 
If the problem still remains, there is probably a hardware resource 
conflict between the host adapter and other hardware in your 
computer. You can fix this by changing the hardware resource 
settings. (See your hardware documentation.)

What do I need to do if I change or upgrade my host adapter?

1 Open the Control Panel, double-click on System, and click the 
Device Manager tab. 

2 Double-click the SCSI Controllers icon, select the name of the 
old host adapter, and click Remove.

3 Turn OFF the computer and physically remove the currently 
installed host adapter.

4 Install the new host adapter according to the instructions in the 
hardware documentation.

5 Turn the computer ON. If the new host adapter supports Plug 
and Play, Windows will install and configure it automatically. 
Otherwise, run Add New Hardware to make sure the new 
driver is loaded.
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If I am running under Windows 95, do I need lines for the Adaptec real mode ASPI 
drivers and mscdex in my config.sys and autoexec.bat files?
Usually, you do not need to use these Real mode ASPI drivers, because 
the new Windows miniport drivers support most SCSI host adapters 
and SCSI devices. However, you need to load the drivers (including 
mscdex, if you have a CD-ROM drive) if any of the following is true:

■ You are running in MS-DOS mode and need to access your 
CD-ROM drive.

■ You are using a scanner or another SCSI device with config.sys- 
or autoexec.bat-based drivers, such as Hewlett Packard 
sjiix.sys.

■ You have an older model SCSI-1 CD-ROM drive that 
Windows 95 does not support.

■ You are using a CD-Recorder drive (however, some newer 
models of CD-Recorder drives can use the embedded 
Windows miniport drivers).

My CD-ROM drive doesn’t work properly under Windows 95.
Some older models of SCSI CD-ROM drives are not compatible with 
the embedded Windows 95 CD-ROM driver. You can add support 
for the CD-ROM drive by doing the following:

1 Make sure your ASPI Real mode drivers (including aspicd.sys, 
aspi8dos.sys, and mscdex.exe) are loaded and running from 
your config.sys and autoexec.bat files. Refer to the EZ-SCSI 
User’s Guide for more information.

2 If step 1 did not work, find the file named cdtsd.vxd in the 
\windows\system\iosubsys directory and rename it cdtsd.sav.
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My CD-ROM drive shows up as more than one icon under My Computer.
The mapping between mscdex, which runs in Real mode, and the 
Windows 95 CD-ROM driver does not match. You can correct this in 
one of two ways:

■ Comment out the line that loads mscdex.exe in the 
autoexec.bat file.

■ Change the /L switch on the line that loads mscdex.exe in the 
autoexec.bat file so it assigns the CD-ROM drive the next 
highest logical drive letter after the hard disk drives.

❒
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Novell NetWare Installation
This chapter explains how to install the Adaptec 7800 Family 
Manager Driver aic7870.dsk (Ultra SCSI) or aic78u2.ham (Ultra2 
SCSI) for Novell NetWare— NetWare v3.1x, v4.0, and v4.1x. The 
aic7870.dsk driver supports all Adaptec 7800 Family UltraSCSI (and 
earlier) host adapters, and the aic78u2.ham driver supports all 
Ultra2 SCSI adapters. Refer to the list on page 1-3.

If you are performing a first time NetWare installation, see Installing 
the Driver When Installing NetWare on page 4-2. If NetWare is already 
installed in your system, see Installing the Driver When NetWare is 
Already Installed on page 4-4.
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Installing the Driver When Installing NetWare
To install the aic7870.dsk or aic78u2.ham driver when you install 
NetWare, follow the instructions below for the version of NetWare 
you are installing.

NetWare v3.1x
Follow these instructions only if you are installing NetWare v3.1x for 
the first time:

1 Follow the procedures in your NetWare documentation for 
installing a new server.

2 After completing the NetWare installation, exit to DOS.

If you are installing the aic89u2.ham driver, continue on to 
step 3. If you are installing the aic7870.dsk driver, jump to step 
5.

3 Copy all the files from the NetWare 3.12 Patch Disk to the 
c:\server.312 directory. Do this with the following command:

copy a:*.* c:\server.312\server.exe

4 Update the server.exe file with the following command:

lswap c:\server.312\loader.exe c:\server.312

5 Create the startup.ncf with the following lines:

load pm312

pmload c:\server.312

load aic78u2

6 Start server.exe and continue with the installation.
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NetWare v4.0 or v4.1x
Follow these instructions only if you are installing NetWare v4.0 or 
v4.1x for the first time:

1 Begin installation of NetWare v4.0 or v4.1x on your server as 
instructed in your NetWare documentation.

2 When a screen appears that asks you to select a disk driver, 
press Insert.

3 Insert the Adaptec 7800 Family Manager Set diskette for 
NetWare into your disk drive.

4 Press F3 and specify the path to the aic7870.dsk or 
aic78u2.ham driver for NetWare (e.g., a:\netware\v4_xx on the 
diskette).

5 Select AIC7870.DSK or AIC78U2.HAM and press Enter.

6 Press Alt-ESC. From the console prompt type the following:

load a:\netware\aic7870.dsk

or

load a:\netware\aic78u2.ham

7 Press Enter. A list of slot numbers separated by commas is 
displayed. Write down all slot numbers listed. Do not press 
Enter.

8 Press ESC twice.

9 At the prompt, press Alt-ESC.

10 Choose Select/Modify Driver Parameters then press Enter.

11 Type the slot number and press Enter.

12 Press F10, or ESC. 

13 Choose Save Parameters and Continue, and press Enter.

14 To install additional adapters, follow the procedures from step 
10.

15 When complete, select Continue the Installation to complete the 
installation.
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Note: To load the driver automatically at server bootup, 
make sure the startup.ncf file includes the load command 
line for your host adapter. See Installing the Driver When 
NetWare is Already Installed on page 4-4 and Loading the 
Driver at Server Bootup on page 4-5.

Installing the Driver When NetWare is Already 
Installed
To update or install the aic7870.dsk or aic78u2.ham driver when 
NetWare is already installed, follow the instructions in this section. 
The procedures are similar for all versions of NetWare. Procedures 
that are specific to a NetWare version are noted when necessary.

1 Make a backup copy of the old driver (if it exists) before 
installing the new driver.

2 Copy the aic7870.dsk or aic78u2.ham driver from the 7800 
Family Manager Set diskette for NetWare into the server’s 
startup directory (e.g., c:\nwserver, c:\server.40, c:\server.312) 
on your hard disk. This overwrites any existing version of the 
driver in the directory.

Note: For NetWare v3.1x, the driver file is located in 
the \netware\v3_1x directory on the diskette; for 
NetWare v4.0 and v4.1x, the file is in \netware\v4_xx.

3 If necessary, modify the load command line in the startup.ncf 
file so that the proper path to the driver and all appropriate 
command line options are specified. See Loading the Driver at 
Server Bootup on page 4-5.

The correct syntax to load the 7800 Family driver is

load [pathname]aic7870 [options]

or

load [pathname]aic78u2 [options]

Command line options are not case sensitive. Placing commas 
between command line options is optional. See Loading the 
Driver at Server Bootup on page 4-5 for possible values.
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Loading the Driver at Server Bootup
To automatically load the aic7870.dsk or aic78u2.ham at server 
bootup, the startup.ncf file (usually located in your server’s startup 
directory) must contain a load command line that specifies the 
location of the driver and any appropriate command line options 
(see Using the Load Command Line Options on page 4-7). For 
additional information on the startup.ncf file, refer to your NetWare 
documentation.

Note: To load the driver from your hard disk, the driver and 
aspitran.dsk module must be copied from the 7800 Family 
Manager Set diskette for NetWare to a directory on your 
hard disk [usually the server’s startup directory (e.g., 
c:\nwserver)].

The correct syntax to load the driver is

load [pathname]aic7870 [options]

or

load [pathname]aic78u2 [options]

For example, the command line to load the driver from the 
c:\nwserver directory, with the verbose= option on is

load c:\nwserver\aic7870 verbose=y

or

load c:\nwserver\aic78u2 verbose=y
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Command line options are not case sensitive. Placing commas 
between command line options is optional. See Using the Load 
Command Line Options on page 4-7 for possible values.

To modify the startup.ncf file, follow these steps:

Note: You can also use your DOS text editor to modify the 
startup.ncf file.

1 Type load install at the NetWare prompt and press Enter.

2 Select the appropriate menu choice that allows you to edit the 
startup.ncf file.

3 Make the necessary changes. When you are done, press Esc.
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Using the Load Command Line Options
You can specify several command line options when the driver is 
loaded. The available options are described in the tables below. The 
first table describes the command line options for the aic7870.dsk 
driver for Ultra SCSI and earlier products. The second table 
describes command line options for the aic78u2.ham driver for 
Ultra2 SCSI products.

Table of aic7870.dsk Command Line Options:

Option Values Default Description

auto_bus_fairness= on, off on Enables/disables auto 
SCSI bus fairness 
algorithm.

auto_disable_tagq= on, off on Enables/disables auto 
disable tag queuing 
algorithm.

auto_flush_diskreq= on, off on Enables/disables auto 
disk flush algorithm.

cdrom= on, off on Enables/disable driver 
support for CD-ROM 
devices; on = Driver, off = 
ASPI.

dev_enable= 00-FFFF FFFF Allows you to enable the 
driver's registration of 
SCSI devices on a per 
target basis. By default, all 
targets are scanned. A bit 
value of 0 causes the target 
not to register under the 
operating system. These 
devices are still accessible 
via ASPI. This enable bit 
mask is entered in hex (see 
Bit Mask Options on 
page 4-12).
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ext_tran= yes, no no Determines translation 
method for a new drive in 
the system; yes = 
extended, no = standard. 
By default, standard 
translation is used unless 
set to extended by 
SCSISelect

fixed_disk= on, off on Enables/disables support 
for hard disks. By default, 
hard disks are supported. 
You may want to disable 
hard disk support in order 
to load an ASPI Fixed Disk 
Module.

flush_diskreq= 00-FFFF 0 A bit mask to send 
occasionally ordered tags 
to specific targets. By 
default, no targets receive 
occasionally ordered tags. 
This bit mask is entered in 
hex (see Bit Mask Options 
on page 4-12).

instr= on, off off Enables/disables 
recording of I/O statistics.

io_combine= 1-32 16 Specifies maximum 
number of segments in a 
scatter/gather list. 

lun_enable=1 00-FFFF 01 A bit mask to enable 
scanning for specific LUNs 
on all targets. The default 
value of 01 causes the 
driver to scan LUN 0 only. 
This enable bit mask is 
entered in hex (see Bit 
Mask Options on 
page 4-12.) 

max_tags= 1-128 16 Specifies maximum 
number of tagged 
commands per device.

Option Values Default Description
4-8



Novell NetWare Installation
multlun_targets 00-FFFF FFFF A bit mask to enable LUNs 
on selected targets. By 
default, LUNs on all 
targets are enabled. This 
bit mask is entered in hex 
(see Bit Mask Options on 
page 4-12).

read_after_write 0-1 1 Specifies default verify 
mode; 0 = Off (No verify 
on writes), 1 = On 
(Hardware verify).

removable=1 on, off on Enables/disables support 
for removable media other 
than CD-ROMs. By 
default, removable media 
is supported. You may 
want to disable removable 
disk support in order to 
load an ASPI Removable 
Disk Module.

start_unit 0-FFFF 0 A bit mask to enable 
sending the Start_Unit 
command to specific 
targets. By default, the 
command is not sent to 
any target. This feature is 
not needed by most 
devices. This bit mask is 
entered in hex (see Bit 
Mask Options on 
page 4-12).

tag_disable 0-FFFF 0 A bit mask to disable 
tagged queuing for 
specific targets. By default, 
tagged queuing is enabled 
for all targets. If bit mask is 
set, then tagged queuing 
for that particular device is 
disabled. This bit mask is 
entered in hex (see Bit 
Mask Options on 
page 4-12).

Option Values Default Description
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Table of aic78u2.dsk Command Line Options

slot= 0-xxxx2 0 Defines a physical slot 
number for the host 
adapter. If 0 is specified, or 
if this option is not 
specified, then the driver 
loads for all 7800 Family 
host adapters.

verbose= yes, no no Displays host adapter 
configuration information 
at load time.

1 Many multiple-lun and removable media devices are changers or magazines. Some 
of these are only supported by the driver through an ASPI driver provided by the 
hardware vendor.

2 The values can vary and are dependent on the system configuration.

Option Values Default Description

auto_bus_fairness= on, off on Enables/disables auto 
SCSI bus fairness 
algorithm.

auto_disable_tagq= on, off on Enables/disables auto 
disable tag queuing 
algorithm.

auto_flush_diskreq= on, off on Enables/disables auto 
disk flush algorithm.

dev_enable= 0-FFFF FFFF Allows you to enable the 
driver's registration of 
SCSI devices on a per 
target basis. By default, all 
targets are scanned. A bit 
value of 0 causes the 
target not to register 
under the operating 
system. These devices are 
still accessible via ASPI. 
This enable bit mask is 
entered in hex (see Bit 
Mask Options on 
page 4-12).

Option Values Default Description
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flush_diskreq= 0-FFFF 0 A bit mask to send 
occasionally ordered tags 
to specific targets. By 
default, no targets receive 
occasionally ordered tags. 
This bit mask is entered in 
hex (see Bit Mask Options 
on page 4-12).

lun_enable=1 0-FF 01 A bit mask to enable 
scanning for specific 
LUNs on all targets. The 
default value of 01 causes 
the driver to scan LUN 0 
only. This enable bit mask 
is entered in hex (see Bit 
Mask Options on 
page 4-12.) 

max_tags= 1-128 16 Specifies maximum 
number of tagged 
commands per device.

multlun_targets= 0-FFFF FFFF A bit mask to enable 
LUNs on selected targets. 
By default, LUNs on all 
targets are enabled. This 
bit mask is entered in hex 
(see Bit Mask Options on 
page 4-12).

slot= 0-xxxx1 0 Defines a physical slot 
number for the host 
adapter. If 0 is specified, or 
if this option is not 
specified, then the driver 
loads for all 7800 Family 
host adapters.

verbose= yes, no no Displays host adapter 
configuration information 
at load time.

1 The values can vary and are dependent on the system configuration.

Option Values Default Description
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Bit Mask Options
Use the example below as an aid for calculating bit mask option hex 
values. Each SCSI device is enabled by a 1 in its corresponding bit 
position. The table that follows the figure, lists the binary-to-hex 
conversions. Using this example, if you want to enable scanning for 
LUNs 0, 2, and 6 on all targets, then use the command line option of 
lun_enable=0045.

Sample Load Commands
Here is a simple load command with no option switches (if loaded 
from drive A):

load a:\netware\v3_1x\aic7870

If an error message appears when attempting to load the driver, 
refer to Troubleshooting on page 4-18.

Here is an example of the aic7870.dsk driver being loaded with 
command line options (if loaded from drive A):

load a:\netware\v3_1x\aic7870 verbose=y slot=22

Binary Hex. Binary Hex.

0000 0 1000 8

0001 1 1001 9

0010 2 1010 A

0011 3 1011 B

0100 4 1100 C

0101 5 1101 D

0110 6 1110 E

0111 7 1111 F

SCSI ID

0, 2, 6

0

Converted
binary-to-hex:

= 0045 0 4 5

Bit Position

15
0

14
0

13
0

12
0

11
0

10
0

9
0

8
0

7
0

6
1

5
0

4
0

3
0

2
1

1
0

0
1 Binary

Hex
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Using NetWare and the Host Adapter
This section contains useful information on using NetWare and your 
host adapter.

Using Removable Media
The aic7870.dsk driver module fully supports removable-media 
disk drives, including magneto-optical drives. Removable media is 
treated as a standard SCSI hard disk, with some exceptions:

■ The driver only recognizes and registers media with 512 
bytes/sector.

■ NetWare allows you to mount/dismount the media, and to 
lock/unlock the media.

NetWare’s monitor.nlm program supports several removable media 
options. Follow these steps to view and configure these options:

1 Load monitor.nlm to display the various options.

2 Select Disk Information. All system disk drives appear.

3 Select the removable-media device. The following drive status 
items appear:

Menu Choice Default Value

1. Volume Segments On 
Drive1

1 Valid for both removable and nonremovable types of SCSI disk drives.

(select for list)

2. Read After Write Verify1 Hardware Level

3. Drive Light Status1 Not Supported

4. Driver Operating Status1 Active

5. Removable Drive Mount 
Status2

2 Valid for removable media only

Mounted

6. Removable Drive Lock 
Status2

Not Locked
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Mount Status
Mounting causes a drive to come online as a NetWare storage 
device. Dismounted drives are inactive and cannot be accessed.

Before you eject your current media, you should first dismount it 
(menu choice 5). When the media status is dismounted, you can eject 
the media. However, NetWare does not allow you to dismount it if 
the media is locked.

To insert your new media, wait for the drive to spin-up, and then 
select the Drive Mount option.

Lock Status
If your removable-media device supports the Lock/Unlock feature, 
you can lock the media (menu choice 6). The media must be in the 
Not Locked state before you can eject it. If the media is Locked, it 
cannot be ejected when you press the Eject button.

Verify (aic7870.dsk driver only)
Read After Write Verify (menu choice 2) is set to Hardware Level by 
default. The option can also be set on the command line, see Using 
the Load Command Line Options on page 4-7.

The available options are defined as follows:

Read After Write Verify

Option 
Setting Function

Disabled All writes to SCSI disk drives are with the SCSI 
Write command (2Ah).

Hardware 
Level

All writes to SCSI disk drives are with the SCSI 
Write and Verify command (2Eh). If not 
supported by the drive, behavior is the same as if 
Read After Write Verify is disabled. We 
recommend this setting for best data security.

Software 
Level

Not supported.
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Using the NetWare Tape Backup
Included with Novell NetWare is a server-based tape backup utility 
called sbackup.nlm. This utility allows you to backup server disk 
drives to a server tape drive. The utility supports Adaptec host 
adapters.

Novell NetWare documentation contains instructions for loading 
the server backup software. Refer to the NetWare Server Backup 
Manual to load the tapedai, tsa, and sbackup modules.

1 Once you have loaded aic7870.dsk or aic78u2.ham, load 
tapedai.dsk, tsaxxx.nlm (tsa312.nlm, tsa400.nlm, tsa410.nlm), 
and sbackup with these options:

:load tapedai
:load tsaxxx
:load sbackup

The appropriate driver that interfaces sbackup to ASPI is 
loaded automatically.

If you are duplexing the Adaptec 7800 Family host adapter with 
another host adapter for NetWare drive mirroring, you must 
also load the appropriate ASPI manager (.dsk) for the second 
host adapter.

2 When sbackup is loaded, it asks for a login name. Enter the 
appropriate name.

3 If sbackup asks you to select the device driver, select the HP 
DIBI-2 Tape Driver, regardless of the type of SCSI tape drive 
being attached (e.g., even if the tape drive is manufactured by 
Wangtek, do not select the Wangtek driver).

Note: Novell also includes a driver called adaptec.nlm. 
This driver is not needed and should not be loaded. 
Adaptec’s driver module takes advantage of ASPI 
interface features bypassed by adaptec.nlm.

Novell publishes a list of SCSI tape drives supported by 
sbackup.nlm.
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Using a CD-ROM with NetWare
To use a CD-ROM with NetWare v3.1x, v4.0, or v4.1x, follow these 
instructions:

1 Load aic7870.dsk or aic78u2.ham by entering the following 
line:

:load [pathname]aic7870

or

:load [pathname]aic78u2

2 If using an Ultra SCSI host adapter, load aspicd.dsk by 
entering the following line:

:load [pathname]aspicd

For multiple LUN CDs, enable multiple LUN scanning with 
the lun_enable switch (e.g., load aspicd lun_enable=FF). The 
lun_enable switch is not needed for aic7870.dsk or 
aic78u2.ham.

3 Load cdrom.nlm by entering the following line:

:load [pathname]cdrom.nlm

Note: For NetWare 4.01 and 4.02 only: You have to load 
nwpa.nlm before you can load cdrom.nlm.

4 Enter the following line at the prompt and then note the 
number and name of the CD:

:cd device list

5 Enter the number or volume name of the CD at the command 
line:

:cd mount [x] [name]
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Optimizing Performance
The Adaptec 7800 Family SCSI Bus Master firmware increases the 
SCSI performance of the Adaptec 7800 Family host adapters under 
multitasking environments. The firmware uses a paging mechanism 
to handle up to 255 simultaneous SCSI commands. The sequencer 
can simultaneously manage up to 128 tagged, or 1 nontagged, SCSI 
commands for each SCSI device, up to a limit of 255 SCSI 
commands. The firmware can queue as many commands as the 
operating system is able to send to the host adapter. To set this 
feature, enter the following command:

max_tags=n

In general, a low number of max_tags gives better sequential 
performance, and a high number a better random performance.

Note: A large number of max_tags can also cause starvation 
problems leading to deactivations with some drives.
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Troubleshooting

Error Messages
The error messages listed below are the messages associated with 
the aic7870.dsk or aic78u2.ham driver. Messages are listed 
sequentially according to the last three digits of the error code. For 
example, [xxxxx080], [xxxxx081], [xxxxx082], etc.

Note: When reporting problems to Customer Support, be 
sure to include the complete error code in your problem 
description.

[xxxxx080] Unable to allocate memory
This indicates that there may be a problem with the amount of 
memory installed in your system. Verify that your system has at 
least the minimum amount of memory required by your operating 
system.

[xxxxx081] Adapter software initialization failure
An error has occurred while the driver was setting up its internal 
data structures. Verify that your adapter is supported by this version 
of the driver.

[xxxxx082] Internal driver error 
An error has occurred while the driver was setting up its internal 
data structures. Try installing the most up-to-date version of the 
driver available from the Adaptec Web site or BBS.

[xxxxx083] Adapter not supported by this version of the driver
Your adapter is not supported by the driver on your system. You 
may have installed a new adapter and have not updated the driver 
on your system.

[xxxxx084] Adapter software initialization failure
An error has occurred while the driver was setting up its internal 
data structures. Try installing the most up-to-date version of the 
driver available from the Adaptec Web site or BBS.
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[xxxxx085] Unable to allocate memory 
This indicates that there may be a problem with the amount of 
memory installed in your system. Verify that your system has at 
least the minimum amount of memory required by your operating 
system.

[xxxxx087] Internal driver error 
An error has occurred while the driver was setting up its internal 
data structures. Try installing the most up-to-date version of the 
driver available from the Adaptec Web site or BBS.

 [xxxxx088] Adapter software initialization failure 
An error has occurred while the driver was setting up its internal 
data structures. Try installing the most up-to-date version of the 
driver available from the Adaptec Web site or BBS.

[xxxxx089] Unable to allocate memory 
This indicates that there may be a problem with the amount of 
memory installed in your system. Verify that your system has at 
least the minimum amount of memory required by your operating 
system.

[xxxxx096] Adapter hardware initialization failure - possible resource conflict 
The driver has attempted to initialize the adapter hardware but 
failed. This might suggest that the adapter resources (e.g., IRQ) 
conflict with the resources of another board installed in your system.

[xxxxx099] Adapter software initialization failure
[xxxxx09a] Adapter software initialization failure
[xxxxx09b] Adapter software initialization failure
An error has occurred initializing one of the driver’s internal data 
structures for a device connected to the adapter. This may result in 
problems accessing the device. Try installing the most up-to-date 
version of the driver available from the Adaptec Web site or BBS.

[xxxxx0ab] Driver already loaded for this host bus adapter
The driver is already loaded for this adapter. Verify that the correct 
adapter is specified in your command line or startup file.

[xxxxx0ac] Driver already loaded for all host bus adapters
The driver is already loaded for all the supported adapters in this 
system.
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[xxxxx0a4] SCSI bus reset by third party hardware
Hardware such as an array enclosure may have reset the SCSI bus. 
This is a normal condition unless you receive additional errors.

[xxxxx0a7] Unable to allocate memory
[xxxxx0a8] Unable to allocate memory
This indicates that there may be a problem with the amount of 
memory installed in your system. Verify that your system has at 
least the minimum amount of memory required by your operating 
system.

[xxxxx0a9] Possible interrupt conflict
This indicates that the adapter IRQ conflicts with the IRQ of another 
board installed in your system. Check your hardware 
documentation for instructions on setting and changing IRQs.

[xxxxx0c9] Invalid command line parameter 
A command line option for the driver is invalid. See Using the Load 
Command Line Options on page 4-7 for valid command line options.

[xxxxx0ca] Invalid command line syntax
[xxxxx0cb] Invalid command line syntax
[xxxxx0cc] Invalid command line syntax
The command line syntax for the driver is incorrect. See Using the 
Load Command Line Options on page 4-7 for entering the correct 
syntax.

[xxxxx07c] Unable to allocate memory
[xxxxx07d] Unable to allocate memory
[xxxxx07e] Unable to allocate memory
[xxxxx07f] Unable to allocate memory
This indicates that there may be a problem with the amount of 
memory installed in your system. Verify that your system has at 
least the minimum amount of memory required by your operating 
system.

❒
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IBM OS/2 Installation
This chapter explains how to install the Adaptec 7800 Family 
Manager Set Driver for OS/2. The aic7870.add driver supports 
Ultra SCSI devices for OS/2 v.2.1x, and OS/2 Warp3.x, 4.x, and 4.x 
SMP. The aic78u2.add driver supports Ultra2 SCSI devices for OS/2 
Warp 3.x, 4.x, and 4.x SMP. Refer to the list of devices on page 1-3.

If you are installing OS/2 for the first time, see Installing the Driver 
When Installing OS/2 on page 5-1. If OS/2 is already installed in your 
system, see Installing the Driver When OS/2 is Already Installed on 
page 5-6.

Installing the Driver When Installing OS/2
To install the aic7870.add or aic78u2.add driver at the same time 
you install OS/2, follow the instructions below for the version of 
OS/2 you are installing.

Note: When installing OS/2 from a CD-ROM, be sure the 
CD-ROM SCSI ID is not set to 0 or 7.
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Installing OS/2 v2.1x (Ultra SCSI Driver Only)
Follow these instructions only if you are installing OS/2 v2.1x for the 
first time. We assume here that OS/2 is not already installed on the 
system. You will need to have access to a computer where you can 
copy DOS files from one diskette to another.

Note: To install the aic7870.add driver, it is necessary to 
copy the driver from the 7800 Family Manager Set diskette 
for OS/2 on to the OS/2 installation diskette #1. However, 
before you can copy the driver, you must first remove 
various files from the OS/2 installation diskette #1, as 
explained in step 2 below.

1 Go to a computer on which DOS, Windows®, or OS/2 is 
already installed. Use diskcopy to make backup copies of all 
IBM OS/2 and Adaptec-supplied diskettes. Use the backup 
copies as your working diskettes.

2 Delete some of the existing files on the backup copy of the 
OS/2 diskette #1 so that approximately 120 KBytes of disk 
space is available on the diskette. Use the following 
information to help you decide which files to delete:

– If the Adaptec 7800 Family host adapter is the only Adaptec 
host adapter installed in your system, delete all Adaptec 
drivers (aha152x.add, aha154x.add, aha164x.add, 
aha174x.add, aic7770.add, and fd16_700.add).

– If you have an Adaptec host adapter that is not part of the 
7800 Family, delete all of the Adaptec drivers not used by 
that particular host adapter. For example, if you have an 
Adaptec AHA-1540CP host adapter installed in your 
computer, delete all Adaptec drivers except for the 
aha154x.add driver.

– If you have deleted the suggested Adaptec drivers above, 
and you still do not have approximately 120 KBytes of disk 
space available on the diskette, delete these files: 
ibm2flpy.add, ibm2adsk.add, and ibm2scsi.add.

3 Copy the os2ldr file from the 7800 Family Manager Set diskette 
for OS/2 (i.e., \os2\aic7870\) onto the OS/2 installation 
diskette.
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4 Copy the ibmint13.i13 and the aic7870.add files from the 7800 
Family Manager Set diskette for OS/2 (i.e., \os2\aic7870\) onto 
the 
OS/2 diskette # 1.

5 Add the following line to the config.sys file on diskette #1:

basedev=aic7870.add

6 Run the OS/2 v2.1x installation program; follow the 
instructions in your OS/2 documentation.

7 At the end of the installation process, follow the onscreen 
instructions to remove the last OS/2 distribution diskette and 
reboot the computer.

8 After the computer has restarted, OS/2 displays a welcome 
screen. You have the option to view online information while 
the OS/2 desktop is building. Allow OS/2 to finish building.

Note: Refer to the readme.txt file for any additional 
information on installing OS/2 v2.1x and the driver.

Installing OS/2 Warp 3.x, 4.x, and 4.x SMP
Follow these instructions only if you are installing OS/2 Warp 3.x, 
4.x, and 4.x SMP for the first time. The instructions are the same for 
these versions of OS/2, unless otherwise stated. We assume here 
that OS/2 is not already installed on the system. You will need to 
have access to a computer where you can copy DOS files from one 
diskette to another.

Note: To install the aic7870.add or aic78u2.add driver, it is 
necessary to copy the driver from the Adaptec 7800 Family 
Manager Set diskette for OS/2 on to the OS/2 installation 
diskette #1. However, before you can copy the driver, you 
must first remove various files from the OS/2 installation 
diskette #1, as explained in step 2 below.

1 Go to a computer on which DOS, Windows, or OS/2 is already 
installed. Use diskcopy to make backup copies of all IBM OS/2 
and Adaptec-supplied diskettes. Use the backup copies as 
your working diskettes.
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2 Delete some of the existing files on the backup copy of the 
OS/2 installation diskette #1 so that approximately 140 KBytes 
of disk space is available on the diskette. Use the following 
information to help you decide which files to delete:

– If the Adaptec 7800 Family host adapter is the only Adaptec 
host adapter installed in your system, delete all Adaptec 
drivers (aha152x.add, aha154x.add, aha164x.add, 
aha174x.add, aic7770.add, and fd16_700.add).

– If you have an Adaptec host adapter that is not part of the 
7800 Family, delete all of the Adaptec drivers not used by 
that particular host adapter. For example, if you have an 
Adaptec AHA-1540CP host adapter installed in your 
computer, delete all Adaptec drivers except for the 
aha154x.add driver.

– If you have deleted the suggested Adaptec drivers above, 
and if you do not have a Microchannel architecture system, 
and you still do not have approximately 120 KBytes of disk 
space available on the diskette, delete these files: 
ibm2flpy.add, ibm2adsk.add, and ibm2scsi.add.

Note: If you have a combination PCI/Microchannel 
architecture system, you need to delete third-party 
driver files not required.

3 Copy the aic7870.add or aic78u2.add driver from the 7800 
Family Manager Set diskette for OS/2 onto the OS/2 
installation diskette #1. This overwrites any existing version of 
the driver included on diskette #1. 

Note: The aic7870.add driver resides in the 
\os2\aic7870 directory and the aic78u2.add driver 
resides in the \os2\aic78u2 directory.
5-4



IBM OS/2 Installation
4 For each driver removed from the OS/2 diskette #1, remove its 
corresponding line in the config.sys file (also on OS/2 diskette 
#1).

For example, if you deleted all Adaptec drivers, as explained in 
Step 2a, above, remove the following lines from the config.sys 
file:

basedev=aha152x.add
basedev=aha154x.add
basedev=aha164x.add
basedev=aha174x.add
basedev=aic7770.add
basedev=fd16_700.add

5 In the config.sys file on OS/2 diskette #1, add the following 
line:

set copyfromfloppy=1

This line must be added so that the install process copies the 
aic7870.add or aic78u2.add driver from the OS/2 diskette #1, 
instead of the aic7870.add driver included on your OS/2 CD-
ROM.

Note: For OS/2 Warp 4.0 or 4.0 SMP users only, add 
the basedev=aic7870.add or basedev=aic78u2.add 
line to the top line of the config.sys file on OS/2 
diskette #1. This will result in two 
basedev=aic7870.add or basedev=aic78u2.add 
statements existing in the config.sys file.

6 Run the OS/2 installation program; follow the instructions in 
your OS/2 documentation until you reach the System 
Configuration window.

7 In the System Configuration windows, click the SCSI Adapter 
Support icon.

8 Deselect any highlighted adapters (including the Adaptec 
294x, 394x, AIC7870 PCI SCSI), and click OK. The text box for 
SCSI Adapter Support should say None.
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Note: If these adapters are not deselected, the driver 
included on the CD-ROM will be copied over the 
driver being installed.

9 Follow the instructions in your OS/2 documentation to 
complete the installation.

Note: The update files os2ldr and ibmint13.i13 included with 
the Adaptec 7800 Family Manager Set are not needed when 
installing OS/2 Warp.

After installation is complete, verify that only one 
basedev=aic7870.add statement exists in the config.sys file 
on your hard drive. Remove other instances if more than 
one is found.

Installing the Driver When OS/2 is Already 
Installed
To update or install the aic7870.add or aic78u2.add driver if OS/2 is 
already installed, follow the instructions below. The procedures are 
similar for all versions of OS/2. Procedures that are specific to an 
OS/2 version are noted when necessary.

1 If you are updating the driver, simply copy the aic7870.add or 
aic78u2.add driver from the 7800 Family Manager Set diskette 
for OS/2 (e.g., \os2\aic7870.add or \os2\aic78u2.add) into the 
\os2 directory (for OS/2 v2.1x) or \os2\boot directory (for OS/2 
Warp 3.x, 4.x, or 4.x SMP) on your hard disk. (Make a backup 
copy of the older driver before doing this.) This overwrites any 
existing version of the driver in the directory. Updating of the 
driver is complete; do not continue with Steps 3 through 5.

Note: The aic78u2.add driver does not support OS/2 
v2.1x

If OS/2 has been installed and does not recognize the Adaptec 
7800 Family host adapter, or if you are adding your Adaptec 
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7800 Family host adapter to your OS/2 computer, you need to 
install the driver. To do so, continue with Step 2:

2 Run the ddinstal program by selecting the Device Driver 
Install icon from the System Setup folder or by typing ddinstal 
at the OS/2 prompt. 

Note: If you are running OS/2 v2.1x, change to the 
directory containing aic7870.add and associated files 
and run ddinstal from the OS/2 prompt.

Caution: If you are running OS/2 v2.1x GA, do not run 
Device Driver Install from the System Setup folder. 
Instead, open a full screen OS/2 session and change to 
the drive with the 7800 Family Manager Set diskette 
for OS/2. Then type ddinstal and press Enter.

3 Insert the Adaptec 7800 Family Manager Set diskette for OS/2 
in the appropriate disk drive and follow the prompts from 
ddinstal.

4 The computer scans for the host adapter(s). If a host adapter is 
found, the Installing Device Drivers message appears. Another 
message appears when the driver is successfully installed. If 
no host adapters are found, an error message appears.

5 Reboot the computer for the changes to take effect.

!
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Using Command Line Options
Once installed, the aic7870.add or aic78u2.add driver does not 
usually require any modifications to its configuration. In certain 
situations, however, you may wish to add command line options to 
the driver to meet your specific needs. The command line options 
described in this section can be used in OS/2 v2.1x and OS/2 Warp 
3.x and 4.x.

The aic7870.add or aic78u2.add driver command line resides in the 
config.sys file. Command line options are not case sensitive, and 
take effect after the computer is rebooted. The command line syntax 
is

basedev=aic7870.add [Universal Parameters] [Adapter ID] 
[Unit Parameters: [SCSI Target ID]]

or

basedev=aic78u2.add [Universal Parameters] [Adapter ID] 
[Unit Parameters: [SCSI Target ID]]

Caution: Your computer may not boot if you enter the 
command line options incorrectly.

Universal Parameters
/et
Embedded targets allowed. Makes the driver assume that all targets 
have more than one Logical Unit Number (LUN) defined.

/!et
No embedded targets allowed. Makes the driver assume that all 
targets have only one LUN defined. (This is the default setting.)

/v
Verbose mode. Information such as the driver name, version 
number, and Adaptec copyright appears if the driver loads 
successfully. Also displays information about all targets found in the 
computer.

!
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/pcihw
PCI configuration hardware registers. Enables driver to access PCI 
configuration hardware registers. This switch is available for some 
PCI systems that run into problems when trying to access PCI 
configuration space through PCI BIOS function calls. (This is the 
default setting.)

/!pcihw
Disables the /pcihw switch. This parameter will cause the driver to 
access the PCI configuration space though PCI BIOS function calls.

Adapter ID
/a:n
Adapter numbers are assigned based on BIOS address (starting from 
the lowest first) and the Device number (PCI Device number in hex 
as seen at the upper right hand corner of the first SCSISelect screen) 
if the BIOS is disabled. Built-in single-channel host adapters are 
generally assigned ID 0 (zero), as the first found adapter.

Unit Parameters
Replace the italicized letters (x,y,z) in the switch descriptions below 
with the SCSI target ID(s) of the device(s) that you want affected. 
The IDs may be a single ID (x) or a list of IDs (x,y,z). The IDs must be 
separated by commas.

/dm: x,y,z
Enables Direct Access Storage Device (DASD) manager support. 
Allows os2dasd.dmd to control the specified target(s) when they are 
identified as DASD devices. (This is the default setting.)

/!dm: x,y,z
Disables DASD manager support. Prevents os2dasd.dmd from 
controlling the specified target(s).

Caution: Do not disable DASD manager support to the boot 
drive, or the computer will not be able to boot.!
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/sm: x,y,z
Enables SCSI manager support for the target device(s) x,y,z. Allows 
os2scsi.dmd to control the specified target(s) if they are identified as 
non-DASD SCSI devices. All SCSI hard drives are controlled by 
os2dasd.dmd. (This is the default setting.)

/!sm: x,y,z
Disables SCSI manager support. Prevents os2scsi.dmd from 
controlling the specified target(s).

/tag: x
Specifies the maximum number of tagged commands for all target 
devices on the host adapter (1-16). A value of 1 disables tagged 
queuing. The maximum number allowed is 16. (The default is 8.)

/i
Ignores the host adapter. The driver ignores the host adapter so that 
another driver may control it.

/ur
Enables reporting of underruns.

/!ur
Disables reporting of underruns. (This is the default setting.)
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Command Line Examples

Example 1
Suppose that you have a removable-media drive as target 3. 
Normally os2dasd allocates this device, treats it as a large floppy, 
and prevents you from sending any SCSI commands via another 
device manager. The command line below prevents os2dasd.dmd 
from accessing the target and allows os2scsi.dmd and os2aspi.dmd 
to share access to it:

basedev=aic7870.add /a:0 /!dm:3

or

basedev=aic78u2.add /a:0 /!dm:3

Example 2
Suppose that you have a multidisk CD-ROM as target 4 on host 
adapter 0 and two DASD devices as targets 1 and 5 on host adapter 
1. The command line below prevents os2scsi.dmd from accessing 
the CD-ROM and os2dasd.dmd from controlling the DASD devices. 
The driver searches for multiple LUNs on all devices.

basedev=aic7870.add /et /a:0 /!sm:4 /a:1 /!dm:1,5

or

basedev=aic78u2.add /et /a:0 /!sm:4 /a:1 /!dm:1,5

Note: There are no switches for directly controlling 
os2aspi.dmd, the ASPI device manager.
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Troubleshooting

Problems and Solutions

How do I assign an interrupt for the host adapter?
The interrupt assignment is handled via the motherboard BIOS. You 
may or may not be able to assign an interrupt manually. Refer to 
your motherboard or system documentation.

During installation, OS/2 fails to find the hard drive.
Make sure the latest driver from Adaptec has been installed. Add 
the /pcihw or /!pcihw command option to the basedev=aic7870.add 
(or aic78u2.add) driver statement in the config.sys file.

Does extended translation need to be enabled on the host adapter to support drives 
greater than 1GByte?
Under OS/2, if you are using a FAT file system and/or switching 
back and forth from DOS, extended translation should be enabled. If 
you are using HPFS (High Performance File System), extended 
translation may or may not be enabled. Once the driver for the host 
adapter loads, the remaining hard drive space will be seen beyond 
1024KBytes.

Error Messages
The error messages listed below are the messages associated with 
the aic7870.add or aic78u2.add driver. Messages are listed 
sequentially according to the last three digits of the error code. For 
example, [xxxxx080], [xxxxx081], [xxxxx082], etc.

Note: When reporting problems to Customer Support, be 
sure to include the complete error code in your problem 
description.

[xxxxx080] Unable to allocate memory
This indicates that there may be a problem with the amount of 
memory installed in your system. Verify that your system has at 
least the minimum amount of memory required by your operating 
system.
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[xxxxx081] Adapter software initialization failure
An error has occurred while the driver was setting up its internal 
data structures. Verify that your adapter is supported by this version 
of the driver.

[xxxxx082] Internal driver error 
An error has occurred while the driver was setting up its internal 
data structures. Try installing the most up-to-date version of the 
driver available from the Adaptec Web site or BBS.

[xxxxx083] Adapter not supported by this version of the driver
Your adapter is not supported by the driver on your system. You 
may have installed a new adapter and have not updated the driver 
on your system.

[xxxxx084] Adapter software initialization failure
An error has occurred while the driver was setting up its internal 
data structures. Try installing the most up-to-date version of the 
driver available from the Adaptec Web site or BBS.

[xxxxx085] Unable to allocate memory 
This indicates that there may be a problem with the amount of 
memory installed in your system. Verify that your system has at 
least the minimum amount of memory required by your operating 
system.

[xxxxx087] Internal driver error 
An error has occurred while the driver was setting up its internal 
data structures. Try installing the most up-to-date version of the 
driver available from the Adaptec Web site or BBS.

 [xxxxx088] Adapter software initialization failure 
An error has occurred while the driver was setting up its internal 
data structures. Try installing the most up-to-date version of the 
driver available from the Adaptec Web site or BBS.

[xxxxx089] Unable to allocate memory 
This indicates that there may be a problem with the amount of 
memory installed in your system. Verify that your system has at 
least the minimum amount of memory required by your operating 
system.
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[xxxxx096] Adapter hardware initialization failure - possible resource conflict 
The driver has attempted to initialize the adapter hardware but 
failed. This might suggest that the adapter resources (e.g., IRQ) 
conflict with the resources of another board installed in your system.

[xxxxx099] Adapter software initialization failure
[xxxxx09a] Adapter software initialization failure
[xxxxx09b] Adapter software initialization failure
An error has occurred initializing one of the driver’s internal data 
structures for a device connected to the adapter. This may result in 
problems accessing the device. Try installing the most up-to-date 
version of the driver available from the Adaptec Web site or BBS.

[xxxxx0a7] Unable to allocate memory
This indicates that there may be a problem with the amount of 
memory installed in your system. Verify that your system has at 
least the minimum amount of memory required by your operating 
system.

[xxxxx0a9] Possible interrupt conflict
This indicates that the adapter IRQ conflicts with the IRQ of another 
board installed in your system. Check your hardware 
documentation for instructions on setting and changing IRQs.

[xxxxx0c9] Invalid command line parameter 
A command line option for the driver is invalid. See Using Command 
Line Options on page 5-8 for valid command line options.

[xxxxx0ca] Invalid command line syntax
[xxxxx0cb] Invalid command line syntax
[xxxxx0cc] Invalid command line syntax
The command line syntax for the driver is incorrect. See Using 
Command Line Options on page 5-8 for entering the correct syntax.
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[xxxxx07c] Unable to allocate memory
[xxxxx07d] Unable to allocate memory
[xxxxx07e] Unable to allocate memory
[xxxxx07f] Unable to allocate memory
This indicates that there may be a problem with the amount of 
memory installed in your system. Verify that your system has at 
least the minimum amount of memory required by your operating 
system.

❒
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SCO UNIX Installation
This chapter explains how to install the Adaptec 7800 Family 
Manager Set Driver alad or alad325 (for Ultra SCSI), and blad or 
blad325 (Ultra2 SCSI) for SCO UNIX—SCO UNIX 3.2v4.2, SCO 
OpenDesktop 3.0 (ODT 3.0), SCO OpenServer 3.0, and SCO 
OpenServer 5.

The alad and blad drivers (or packages) are used with SCO UNIX 
3.2v4.2 based products (SCO UNIX 3.2v4.2, SCO ODT 3.0, or SCO 
OpenServer 3.0). The alad325 and blad325 drivers (or packages) are 
used with SCO OpenServer 5. The alad and alad325 drivers support 
Ultra SCSI and earlier Adaptec 7800 host adapters, the blad and 
blad325 drivers support Ultra2 Adaptec 7800 host adapters. Refer to 
the Adaptec 7800 Family host adapters on page 1-3.

If you are performing a first time SCO UNIX installation, see 
Installing the Driver When Installing SCO UNIX on page 6-2 to begin 
driver installation. If SCO UNIX is already installed in your system, 
see Installing the Driver When SCO UNIX is Already Installed on 
page 6-5.

Note: If you are installing SCO UNIX products with a SCSI 
tape drive, set the tape drive to SCSI ID 2; if you are 
installing with a CD-ROM, set the CD-ROM drive to SCSI 
ID 5 as recommended by SCO.
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Installing the Driver When Installing SCO UNIX
To install the alad/alad325 or blad/blad325 drivers at the same time 
you install SCO UNIX, follow the instructions below for the version 
of SCO UNIX you are installing.

Installing SCO UNIX 3.2 v4.2, SCO ODT 3.0, or 
SCO OpenServer 3.0
Follow these instructions only if you are installing SCO UNIX 
3.2v4.2, SCO ODT 3.0, or SCO OpenServer 3.0 for the first time. The 
instructions for installing the driver are the same for these SCO 
products.

Note: Remember that UNIX commands are case sensitive. 
Enter the commands exactly as shown in the instructions.

1 Insert the SCO UNIX N1 (Boot) floppy diskette into the 
primary floppy drive and turn ON the computer.

2 When you see these prompts

SCO UNIX System V/386
Boot
:

type link and press Enter.

Note: Do not use the link command to install the driver 
for SCO OpenServer 5. See Installing SCO OpenServer 5 
on page 6-4.

3 Type alad or blad as the package you want linked to the system 
and press Enter. 
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4 Insert the requested volume (7800 Family Manager Set diskette 
for SCO UNIX) in the floppy drive and press Enter. Prompts 
similar to the following appear until the driver is completely 
loaded:

alad.alad:Loading module fd(52)/alad/driver/alad/Driver.o 
.text ..........
 :
 :
 alad: Driver “alad” successfully loaded.

5 When prompted to insert the SCO UNIX N2 (Filesystem) 
diskette, remove the 7800 Family Manager Set diskette for SCO 
UNIX from the floppy drive, and then insert the SCO UNIX N2 
(Filesystem) diskette and press Enter.

6 Follow the procedures in your SCO UNIX documentation for 
completing the installation until you have reached and 
completed the Password procedure.

Note: For SCO UNIX 3.2v4.2 only: When the run-time 
installation is complete, make sure you select the 
Install Additional Software option. This ensures that 
the Link Kit is installed and available for later driver 
integration.

7 After completing the Password procedure, a message similar 
to the following appears:

The BTLD packages will now be added to the Link Kit.

The following packages are on this disk.
NAME DESCRIPTION
alad Adaptec 7800 Family Driver for SCO UNIX 3.2v4.2/dxx
alad325 Adaptec 7800 Family Driver for SCO OpenServer 5/dxx

blad Adaptec 7800 U2 Family Driver for SCO UNIX 3.2v4.2
blad325 Adaptec 7800 U2 Family Driver for SCO OpenServer 5

Please enter the names of the packages you
wish to install or q to quit:__
[default: alad]
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8 Type alad or blad and press Enter. The alad driver for your 
7800 Family host adapter has been relinked to the SCO UNIX 
kernel.

Installation is complete!

Installing SCO OpenServer 5
1 Insert the SCO OpenServer 5 Boot floppy diskette into the 

primary floppy drive and turn ON the computer.

2 When you see these prompts

SCO OpenServer (TM) Release 5
Boot
:

type link and press Enter.

3 Type alad325 or blad325, or type ahslink for OpenServer 5.00, 
as the package you want linked to the system and press Enter. 

4 Insert the requested volume (i.e., the 7800 Family Manager Set 
diskette for SCO UNIX) in the floppy drive and press Enter. If 
your driver is already embedded, several messages appear 
including a message similar to

Table “io_init” contains (at 21) another routine named 
“aladinit.”

Please enter

Which (0-40) to replace (‘?’ to list),
‘a’ to add “aladinit” at the end [default]/
‘n’ to do nothing
or ‘q’ to quit:

5 If the above message does not appear, skip to step 6. 
Otherwise, enter the corresponding number for “aladinit or 
bladinit.” In the above example, the number 21 appears in the 
Table “io_init” contains (at 21) another routine named “aladinit” 
message, and is the number that should be entered. If you are 
unsure of which number to use, enter a “?” to list possible 
values; use the number that is listed next to “aladinit.’ In 
general, enter 21 for OpenServer 5.0.0 and 5.0.2, and enter 25 
for 5.0.4.
6-4



SCO UNIX Installation
6 If the driver is properly loaded, the following message 
appears:

alad.alad:Loading module fd(52)/alad/driver/alad/Driver.o 
.text ..........
 :
 :
 alad325: Driver “alad” successfully loaded.

7 Insert the Boot floppy diskette and press Enter.

Follow the procedures in your SCO UNIX documentation for 
completing the installation.

Installing the Driver When SCO UNIX is Already 
Installed
To update or install the alad/alad325 driver if SCO UNIX is already 
installed, follow the instructions in this section. The procedures are 
similar for all versions of SCO UNIX. Procedures that are specific to 
a SCO version are noted when necessary.

Caution: Improper or corrupt driver updates might destroy 
your existing UNIX file system. Back up all important files 
before proceeding.

Installing or updating the driver involves the following tasks, which 
must be completed in the order presented:

■ Perform a System Backup—Backs up the old UNIX kernel and 
any other important files.

■ Use the Install Package—Uses installpkg to load the driver.

■ Modify the mscsi File—Changes the primary host adapter to a 
7800 Family host adapter, if necessary.

■ Rebuild the UNIX Kernel—Rebuilds the kernel to reflect the new 
changes.

■ Boot the New Kernel—Reboots the computer with the new 
kernel.

!
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Note: To update/install the driver, you must first enter the 
Single User Mode (System Maintenance Mode). Refer to the 
SCO UNIX documentation for instructions on how to use 
the init(m) or shutdown(m) command to bring the system to 
System Maintenance Mode.

Perform a System Backup
If you have not already done so, back up all important files on the 
computer by following these steps:

Note: To back up the whole system, refer to your SCO UNIX 
documentation.

1 Log in as root.

2 For SCO 3.2v4.2 based UNIX: To back up the current kernel 
configuration, type the following and press Enter:

cp /unix /unix.orig

For SCO OpenServer 5: To back up the current kernel 
configuration, type the following and press Enter after each 
line:

umount /stand
mount /dev/boot /stand
cp /stand/unix /stand/unix.orig

Note: If you ever need to bootup from the pre-update 
kernel, load the unix.orig backup kernel at the UNIX 
Boot: prompt. To do this, type unix.orig and press 
Enter.

3 This step is optional. For extra security, you may back up the 
mdevice file and the sdevice.d directory. To perform this 
backup, type the following and press Enter:

copy -rom /etc/conf /etc/conf.bak
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Use the Install Package
To load the driver using installpkg, follow these steps:

1 At the UNIX system prompt, type installpkg and press Enter. 
The screen then displays these messages:

Confirm
Please insert the floppy disk
:
:
Strike ENTER when ready
or ESC to stop.

2 Insert the 7800 Family Manager Set diskette for SCO UNIX and 
press Enter. The screen then displays these messages:

Installation is in progress — do not remove the floppy disk.

The following packages are on this disk:

NAME DESCRIPTION
alad Adaptec 7800 Family Driver for SCO UNIX 3.2v4.2/dxx
alad325 Adaptec 7800 Family Driver for SCO OpenServer 5/dxx

blad Adaptec 7800 U2 Family Driver for SCO UNIX 
3.2v4.2/dxx

blad325 Adaptec 7800 U2 Family Driver for SCO OpenServer 
5/dxx

Please enter the names of the packages you wish to install, or q to 
quit:

3 At this point, type alad or blad (or alad325 or blad325 for SCO 
OpenServer 5) and press Enter. The screen then displays this 
message and various installation status prompts:

Installing alad

When the driver is done loading, the following appears:

Installed alad
#

The alad/alad325 driver has now been loaded into the Link Kit 
for kernel addition. 
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Modify the mscsi File
If necessary, to change your primary host adapter to a 7800 Family 
host adapter, follow these steps:

1 Enter this command:

cd /etc/conf/cf.d

2 Enter this command to copy the file:

cp mscsi mscsi.org

3 Use a text editor to edit this file. Enter the following command 
if using the vi editor:

vi mscsi

4 Search for all entries with the host adapter number 0 (zero). 
The host adapter number is the third column in each entry. For 
example:

Host 
Adapter 
Prefix

SCSI 
Device 
Type

Host 
Adapter 
Number

Target 
ID

Logical
Unit 
Number Bus1

1 This field applies to SCO OpenServer 5 only.

xx
xx
xx

Stp
Sdsk
Srom

0
0
0

2
0
5

0
0
0

0
0
0
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5 Modify the mscsi file according to your hardware setup:

– If you are booting from a 7800 Family host adapter, make 
sure the host adapter prefix for the host adapter number 0 is 
alad.

– If you are not booting from a 7800 Family host adapter, 
make sure the host adapter prefix for the host adapter 
number 0 is the appropriate prefix for each device on your 
primary Adaptec host adapter. See the table below:

6 Save the file and exit the text editor.

Rebuild the UNIX Kernel
To rebuild the UNIX kernel with the new changes, follow these 
steps:

1 Type the following at the # prompt and press Enter after each 
line:

cd /etc/conf/cf.d
./link_unix

Status messages appear. 

2 When the kernel has been built, shut down the system by 
typing haltsys and pressing Enter.

3 Turn OFF the system power when you are prompted to do so.

The UNIX kernel has been prepared for 7800 Family host adapter 
operation. 

Host Adapter 
Prefix Type of Driver

Primary Adaptec
Host Adapter

ad
eiad
spad
arad
smad
alad
blad

embedded
embedded
embedded
BTLD
BTLD
BTLD
BTLD

AHA-1540/1640 family
AHA-1740 family
AIC-6260 family
AIC-7770 family
AIC-6260/6360 family
AIC-78xx, AIC-7895
AIC-789x
6-9



Adaptec 7800 Family Manager
Boot the New Kernel
To reboot the computer with the new kernel, follow these steps:

1 Follow the onscreen instructions to reboot your system, 
usually by pressing Enter.

2 Check the host adapter BIOS messages to verify that all your 
installed SCSI devices are listed.

If some or all of your installed SCSI devices do not appear at 
this time, your SCSI cables may be loose, or the SCSI device 
setup may not be complete. If so, go back and correct any 
problem before proceeding.

3 Wait for UNIX to complete bootup with the new kernel.

Refer to Troubleshooting on page 6-13 if the system crashes or if 
panic (UNIX error) messages are displayed during bootup.

The alad/alad325 driver for your 7800 Family host adapter should 
now be ready for use.

Using SCO UNIX and the Host Adapter
This section contains useful information on using SCO UNIX and 
your host adapter.

Using Multiple Host Adapters
If you are adding an additional 7800 Family host adapter to a system 
with a 7800 Family host adapter already installed, follow the 
instructions in the SCO UNIX documentation for adding devices 
using the mkdev command. When the system asks for the host 
adapter prefix, type alad or blad and press Enter.

Changing the Boot Disk
If you are changing the boot device from a non-SCSI hard disk to a 
SCSI hard disk attached to an Adaptec 7800 Family host adapter, 
you must reinstall SCO UNIX.

If you are already booting from a SCSI hard disk and wish to boot 
from a SCSI hard disk attached to an Adaptec 7800 Family host 
adapter, you may elect to either reinstall SCO UNIX with the new 
driver (see Installing the Driver When Installing SCO UNIX on 
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page 6-2), or update SCO UNIX with the new driver (see Installing 
the Driver When SCO UNIX is Already Installed on page 6-5).

Using Wide SCSI Host Adapters and Devices
SCO UNIX 3.2v4.2, SCO ODT 3.0, and SCO OpenServer 3.0 support 
SCSI IDs 0 to 7; SCSI IDs greater than 7 are not recognized. If your 
7800 Family host adapter is a Wide SCSI adapter, only 7 SCSI 
devices (SCSI ID 0 to 6, with the host adapter set at SCSI ID 7) can be 
attached and supported.

SCO OpenServer 5 supports SCSI IDs 0 to 15. If your 7800 Family 
host adapter is a Wide SCSI adapter, up to 15 SCSI devices can be 
attached and supported.

Using Tunable Parameters for the alad Driver
For SCO UNIX, some parameters are defined in the following file:

/etc/conf/pack.d/alad/space.c 

These parameters can be tuned for the alad/alad325 driver. After 
modifying the space.c file, you must rebuild the kernel for the new 
parameters to take effect. The following section describes how to set 
the tunable parameters.

Setting Parameters

If the space.c file has not been modified, all the parameters are set 
according to the SCSISelect utility for your 7800 Family host adapter. 
However, you can override the parameters by modifying the 
space.c file. Changing the parameters is self-explanatory in the 
space.c file. Examples are provided in the following sections.

If you want to change the configured values, the first number 
indicates whether the default should be changed. If it is set to 0 
(zero), the parameter is set to the default. If it is set to 1, the second 
number is used to override the default. For example:

char variable = {1,22};

The first number is 1 which overrides the default variable with the 
value 22.
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Examples

■ alad_parity[SCSI_NALAD]—specifies whether the host adapter 
checks parity on incoming SCSI data. If the second number is 
set to 0, parity checking is enabled. If it is set to 1, parity 
checking is disabled. 

■ alad_parity[SCSI_NALAD]—in this example you want the host 
adapter not to check parity on incoming SCSI data; define 
parameters as

alad_parity[SCSI_NALAD] = {1,0};

Enabling Scatter/Gather and Tagged Queuing
The alad/alad325 driver supports scatter/gather and tagged 
queuing; however, the Sdsk (SCSI disk module) driver controls 
whether these features are enabled or disabled. Look for the Sdsk 
driver controls in the space.c file. It is located at

/etc/conf/pack.d/Sdsk/space.c 
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Troubleshooting

Problems and Solutions

In SCO OpenServer 5, my system hangs after I have installed the driver and rebooted 
the system.
If you are installing OpenServer 5, version 5.0.0, you may have to 
install the SCO OpenServer 5 keyboard patch (available from the 
SCO Web site or BBS) at the same time you install the alad325 
driver. To install the keyboard patch at the same time you install 
SCO OpenServer 5 and the alad325 driver, type the following 
instead of the ahslink command described above:

defbootstr ahslink = “kbp alad325”

Follow the onscreen instructions to insert the SCO keyboard patch 
diskette (kbp) and the 7800 Family Manager Set diskette for SCO 
UNIX when instructed.

I have problems using my SCSI devices.
During bootup, check to see if the BIOS messages for your primary 
7800 Family host adapter lists all installed SCSI devices. If some or 
all devices do not appear, check the following (also check your host 
adapter’s User’s Guide for additional troubleshooting information):

■ Are all SCSI devices powered?

■ Are all SCSI bus cables and power cables properly connected?

■ Do the host adapter and all devices on the SCSI bus have 
unique SCSI IDs?

■ Are all devices on the SCSI bus terminated properly?

■ Do you have an older SCSI peripheral installed? Some older 
SCSI peripherals, especially CD-ROM drives, do not properly 
respond to synchronous negotiation. As a result, these 
peripherals may lock or reset the SCSI bus. To solve this 
problem, turn off synchronous negotiation for this device ID 
through the SCSISelect utility for the host adapter. See the host 
adapter’s User’s Guide.
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My computer does not recognize my host adapter.
During bootup, check to see if the BIOS message for your primary 
7800 Family host adapter appears. If the messages do not appear, the 
host adapter may not be properly configured; check the following:

■ The 7800 Family host adapter supports level-triggered 
interrupts and can share the same interrupt with another 7800 
Family host adapter or PCI hardware that also supports level-
triggered interrupts. Check your host adapter’s User’s Guide 
and your computer documentation for details in configuring 
IRQs and other parameters in the system CMOS setup.

■ The Boot host adapters should be installed into the lowest PCI 
Device number. The Device number is determined by the slot 
number on the PCI bus. 

To find out the Device number of your 7800 Family host 
adapter(s), run the SCSISelect utility (by pressing a key 
combination displayed onscreen at bootup). Look on the first 
screen of SCSISelect in the upper right hand corner for 
Bus:Device xx:xxh (given in hex).

If the Device number is high, power OFF the computer, move 
the 7800 Family host adapter to a PCI slot at the other end of 
the motherboard, and rerun SCSISelect to see if the number is 
lower.

The host adapter LED lights during activity. This light helps to 
determine which adapter SCSISelect displays information for. 
Refer to your system documentation for further details on 
determining the PCI slot number and slot number order in the 
system.
6-14



SCO UNIX Installation
I am having problems booting the computer from a SCSI drive.

■ Make sure your host adapter is installed and configured 
correctly, as described in your host adapter’s User’s Guide. Here 
are some of the things you should check:

Note: If both SCSI and non-SCSI (e.g., IDE) disk drives 
are installed, then the non-SCSI disk drive is always 
the boot device.

– Be sure the Drives setting (in your computer’s CMOS setup 
program) that corresponds to the SCSI boot drive is set to 
None or No Drives Installed, as is required for SCSI hard 
disk drives. (See your computer’s documentation.)

– Be sure the Host Adapter BIOS setting in the SCSISelect 
utility is enabled.

– Be sure the Extended BIOS Translation feature in the 
SCSISelect utility is enabled. The host adapter BIOS 
automatically selects the correct translation method as 
needed.

■ Examine the SCO UNIX mscsi file to make sure the correct 
host adapter and device are specified as the boot entry. The boot 
entry is the first all zero entry in the mscsi file (see Modify the 
mscsi File on page 6-8 for additional information)

For SCO 3.2v4.2 based UNIX, the boot entry looks like this:

alad      Sdsk      0      0      0

or

blad      Sdsk      0      0      0

For SCO OpenServer 5, the boot entry looks like this:

alad      Sdsk      0     0     0     0

or

blad      Sdsk      0     0     0     0

Note: Each field is separated by a tab (do not use the 
spacebar to separate fields).
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The meaning of each field is as follows:

– Host Adapter Prefix—Identifies the name of the host 
adapter driver. If you are booting from a 7800 Family host 
adapter, the Host Adapter Prefix must be alad or blad.

– SCSI Device Type—Identifies the type of SCSI device. For 
example, Sdsk indicates that the device is a hard disk; Srom 
indicates a CD-ROM drive; and Stp indicates a tape drive.

– Host Adapter Number—Identifies the SCSI host adapter 
that the SCSI device is attached to. For example, the first 
7800 Family host adapter is 0, the second 7800 Family host 
adapter is 1.

– Target ID—Identifies the SCSI ID of the SCSI device.

– Logical Unit Number—Identifies the Logical Unit Number 
(LUN) of the SCSI device. This field is usually 0.

– Bus—Identifies the SCSI bus that the SCSI device is attached 
to. For most single channel devices such as the AHA-
2940/2940W, the bus number is 0.

If you need to edit the mscsi file, use the vi editor. You must 
build a new kernel in order for any changes to take effect (see 
Rebuild the UNIX Kernel on page 6-9).

■ If you are booting from a 7800 Family host adapter and are 
using ISA/EISA-based host adapters as secondary devices, 
you must disable the BIOS on all ISA/EISA-based host 
adapters.

If you are booting from ISA/EISA-based host adapters and are 
using a 7800 Family host adapter as a secondary device, see 
your ISA/EISA-based host adapter documentation to ensure 
the host adapter is at the lowest BIOS base address. ISA/EISA-
based host adapters boot before the 7800 Family host adapters.

Host 
Adapter 
Prefix

SCSI 
Device 
Type

Host 
Adapter 
Number

Target
ID

Logical 
Unit 
Number Bus1

1 This field applies to SCO OpenServer 5 only.

alad Sdsk 0 0 0 0

blad Sdsk 0 0 0 0
6-16



SCO UNIX Installation
My computer crashes or displays panic messages during the bootup procedure.
You may have to boot from the backup kernel created earlier. To 
boot from the backup kernel, follow these steps:

1 Reboot the system.

2 At the Booting UNIX System... prompt, type unix.orig and 
press Enter.

Your system should now boot from the backup kernel you 
created prior to the driver update.

Error Messages
The error messages listed below are the messages associated with 
the alad/alad325 or blad/blad325 drivers. Messages are listed 
sequentially according to the last three digits of the error code. For 
example, [xxxxx020], [xxxxx021], [xxxxx022], etc.

Note: When reporting problems to Customer Support, be 
sure to include the complete error code in your problem 
description.

[xxxxx020] Adapter or target device not responding or not connected
The target device did not respond to the adapter. If the device is 
present, refer to your host adapter’s user’s guide for 
troubleshooting information. If the device is no longer connected to 
the system, ignore this error.

[xxxxx022] Adapter or target device protocol error
The adapter or target device has broken the communication 
protocol. A badly behaving device could be causing this message to 
appear. Normally this is not a serious problem. If you get this 
message frequently over a short period of time, it could indicate that 
the device or system is malfunctioning. Unplug or power down 
unused devices to see if the problem persists.

[xxxxx030] Target device busy
[xxxxx032] Target device busy
The target device reports a busy status. Another program might 
already be using this device.
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[xxxxx09D] Unexpected interrupt 
The Adaptec driver received an interrupt from the system that does 
not correspond to any adapter supported by the driver. This could 
be caused by another host adapter from a different vendor, such as a 
video card or a network card. The problem can also be caused by 
malfunctioning hardware.

[xxxxx0a3] Adapter diagnostic failure - possible resource conflict
The driver failed the internal software or hardware diagnostic. Refer 
to your host adapter’s user’s guide for troubleshooting information.

[xxxxx0ca] Cannot initialize device
The system, host adapter, or target device is busy or is not 
responding. The target device could not be initialized.

[xxxxx0cb] Unable to allocate memory. Decrease alad_instr_buffersz in space.c
The driver has requested a larger buffer size than the available 
RAM. Either increase the amount of RAM in the system, or decrease 
the user option alad_instr_buffersz in the 
/etc/conf/pack.d/alad/space.c file.

[xxxxx0cc] CONFLICT: Disconnection must be enabled in order for tag-queueing to 
work
Use the SCSISelect utility of your host adapter to enable 
Disconnection for each device reporting this message. Alternatively, 
disable tagged queuing in /etc/conf/pack.d/alad/space.c file by 
setting alad_do_tagged = 0. If tagged queuing is disabled, 
performance may be negatively affected.

❒
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7▼  ▼  ▼  ▼
SCO UnixWare Installation
This chapter explains how to install the Adaptec 7800 Family 
Managers Set Driver adsl20 or adsl (UltraSCSI) and adsb20 or adsb 
(Ultra2 SCSI) for SCO UnixWare—SCO UnixWare 2.0x and SCO 
UnixWare 2.1.

adsl20 and adsb20 drivers (or packages) are used with SCO 
UnixWare 2.0x. The adsl and adsb drivers (or packages) are used 
with SCO UnixWare 2.1. The adsl and adsl20 support Ultra SCSI 
and earlier Adaptec 7800 host adapters. The adsb and adsb20 
drivers support Ultra2 Adaptec 7800 host adapters. Refer to the 
Adaptec 7800 Family host adapters on page 1-3.

If you are performing a first time SCO UnixWare installation, see 
Installing the Driver When Installing SCO UnixWare on page 7-2 to 
begin driver installation. If SCO UnixWare is already installed in 
your system, see Installing the Driver When SCO UnixWare is Already 
Installed on page 7-3.
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Installing the Driver When Installing SCO 
UnixWare
To install the adsl20/adsl or adsb20/adsb drivers at the same time 
you install SCO UnixWare, follow the instructions below. The 
procedures are the same for SCO UnixWare 2.0x and 2.1.

1 Insert the Install diskette of the SCO UnixWare package into 
the floppy boot drive. Reboot your computer.

Wait for the first SCO UnixWare installation screen and prompt 
to appear, then follow the onscreen instructions.

2 When prompted to either Install Host Bus Adapter Drivers or 
Continue Installation, first remove the Install diskette, then 
select Install Host Bus Adapter Driver and press Enter.

3 Insert the 7800 Family Manager Set diskette for UnixWare 2.x 
into the primary floppy drive and press Enter (you cannot load 
drivers from a secondary floppy drive).

As the driver loads, a message identifying the installed host 
adapter briefly appears on screen. The installation process 
determines which device drivers on the diskettes are needed.

4 If you have additional HBA diskettes, insert the next HBA 
diskette, select Install Another HBA Diskette, and press 
Enter.

If all of your HBA diskettes have been installed, remove the 
last HBA diskette, select Continue Installation, and press 
Enter.

5 If necessary, enter the DCU (Device Configuration Utility) to 
view/change the SCO UnixWare device driver configuration 
data.

6 Follow the onscreen instructions to continue with installation. 
Refer to the SCO UnixWare documentation and onscreen help 
files for help in choosing options.
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Note: If your installation fails, do not attempt to use the 
update installation pkgadd procedure to fix the installation. 
Follow the instructions in the SCO UnixWare 
documentation and in this document to retry the 
installation.

Installing the Driver When SCO UnixWare is 
Already Installed
To update or install the adsl20/adsl or adsb20/adsb drivers on a 
system where SCO UnixWare is already installed, follow the 
instructions in this section. The procedures are similar for SCO 
UnixWare 2.0x and 2.1. Procedures that are specific to a SCO 
UnixWare version are noted when necessary.

Caution: Improper or corrupt driver updates might destroy 
your existing SCO UnixWare file system. Back up all 
important files before proceeding. Consult your SCO 
UnixWare documentation for proper backup procedures.

Installing or updating the driver involves the following tasks, which 
must be completed in the order presented:

■ Back Up the Computer—Backs up the old SCO UnixWare kernel 
and any other important files.

■ Load the Package—Uses pkgadd to load the 7800 Family driver 
package.

■ Modify the New System File—For computers booting from a 
device connected to a 7800 Family host adapter, modifies the 
new driver that was loaded in the previous procedure. 
Loading the driver causes the driver to become a permanent 
part of the new boot kernel on rebuild. 

■ Rebuild the SCO UnixWare Kernel—Rebuilds the kernel with the 
new driver.

■ Boot the New Kernel—Reboots the computer with the new 
kernel.

!
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Note: Remember that SCO UnixWare commands are case 
sensitive. Enter the commands exactly as shown.

Back Up the Computer
If you have not already done so, back up all important files on the 
computer. See your SCO UnixWare documentation for proper SCO 
UnixWare file system backup procedures.

1 Log in as root at the UnixWare # system prompt.

2 To back up the old SCO UnixWare kernel, type the following 
and press Enter:

cp /stand/unix /stand/unix.work

3 To back up the old configuration file, type the following and 
press Enter:

For SCO UnixWare 2.0x:

cp /etc/conf/sdevice.d/adsl20 /save/adsl20

or

cp /etc/conf/sdevice.d/adsb20 /save/adsb20

For SCO UnixWare 2.1:

cp /etc/conf/sdevice.d/adsl /save/adsl

or

cp /etc/conf/sdevice.d/adsb /save/adsb

Load the Package
To load the driver, follow these steps:

1 At the system prompt, type the following and press Enter:

pkgadd -d diskette1

Follow the instructions onscreen to insert the IHV HBA 
diskette (or 7800 Family Manager Set diskette for UnixWare 
2.x) into the floppy boot drive.

2 Select the adsl20/adsl or adsb20/adsb package from the 
onscreen menu and press Enter. The package is loaded into 
your SCO UnixWare operating system.
7-4



SCO UnixWare Installation
3 When the package has loaded, you may be prompted to install 
the diskette again.

Do not reinsert the IHV HBA diskette (or Adaptec 7800 Family 
Manager Set diskette for UnixWare 2.x). Instead, type q (quit) 
and press Enter. 

4 Type mail and press Enter. The mail messages tell you if the 
installation was successful.

If a mail message informs you that the installation has failed, 
turn to Troubleshooting on page 7-11.

5 Type pkginfo and press Enter.

6 Verify that the adsl20/adsl or adsb20/adsb driver is now 
listed. The adsl20/adsl or adsb20/adsb driver appears among 
the other installed packages.

If the adsl20/adsl or adsb20/adsb driver does not appear in 
the pkginfo listing, turn to Troubleshooting on page 7-11.

The listing should be similar to

system adsl Adaptec AIC-7870 PCI SCSI IHV HBA 

or

system adsb Adaptec AIC-7870 PCI SCSI IHV HBA
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Modify the New System File
1 Display the contents of the adsl20/adsl file or adsb20/adsb by 

typing the following and pressing Enter:

For SCO UnixWare 2.0x:

cat adsl20

or

cat adsb20

For SCO UnixWare 2.1:

cat adsl

or

cat adsl

2 If your computer is to boot from a device connected to a 7800 
Family host adapter, verify that the line $static is present 
immediately below the line $version 2.

3 If your computer is not to boot from the host adapter SCSI bus, 
and you wish to leave the driver as a loadable module, edit 
and verify that the line $static is not present directly below the 
line $version 2.
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Rebuild the SCO UnixWare Kernel
To rebuild the UnixWare kernel with the new changes, follow these 
steps:

1 Type the following at the # prompt and press Enter after each 
line:

cd /etc/conf/bin
./idbuild -B

Status messages appear.

2 When the kernel has been built, type the following and press 
Enter after each line (0 in -g0 is zero, not the letter O):

cd /etc/conf/cf.d
cp unix /stand/unix
cd /
shutdown -g0

3 Type y and press Enter when the computer asks if you really 
want to shut down. System Is Down should appear on the 
screen.

The SCO UnixWare kernel is now ready for host adapter operation. 

Boot the New Kernel
To reboot the computer with the new kernel, follow these steps:

1 Follow the onscreen instructions (usually by pressing Enter) to 
reboot your computer.

2 Check the bootup messages to verify that all your installed 
SCSI devices are listed.

If some or all of your installed SCSI devices do not appear at 
this time, your SCSI cables may be loose, or the SCSI device 
setup may not be complete. If so, go back and correct any 
problems before proceeding.

3 Wait for SCO UnixWare to complete bootup with the new 
kernel.

Refer to Troubleshooting on page 7-11 if the computer crashes or 
if panic (SCO UnixWare error) messages appear during 
bootup.

The updated driver for SCO UnixWare should now be ready to use.
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Using SCO UnixWare and the Host Adapter
This section contains useful information on using SCO UnixWare 
and your host adapter.

Using Tunable Parameters
For SCO UnixWare, some parameters are defined in the following 
files:

/etc/conf/pack.d/adsl/space.c

These parameters can be tuned for the adsl20/adsl or adsb20/adsb 
drivers. Please refer to the comments in the appropriate space.c file 
for a description of these parameters. After modifying the space.c 
file, you must rebuild the kernel then reboot the system for the new 
parameters to take effect. To rebuild the kernel, type the following, 
and press Enter after each line:

/etc/conf/bin/idbuild -B
cp /etc/conf/cf.d/unix /stand/unix

Note: The drivers support tagged queuing and 
reinitialization.

Using Multiple Host Adapters
When using multiple host adapters, consider the following:

■ The host adapter and computer must be configured for 
multiple host adapters as explained in the host adapter’s User’s 
Guide.

■ To boot from the 7800 Family host adapter, make sure the host 
adapter is installed in the lowest PCI slot number. See your 
host adapter’s User’s Guide.

■ SCO UnixWare 2.x supports auto-configuration. When adding 
multiple host adapters to an existing SCO UnixWare 2.x 
system, simply install the board and reboot; the system 
automatically reconfigures and rebuilds the kernel. If you want 
to choose a host adapter to boot from, simply disable the BIOS 
on all other host adapters.
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Removing the Driver
If you no longer need the adsl20/adsl or adsb20/adsb driver, you 
can use the following procedure to remove it completely:

1 Back up all important computer files.

2 At the UnixWare root prompt, type the following:

For SCO UnixWare 2.0x:

/etc/conf/bin/idinstall -d adsl20

or

/etc/conf/bin/idinstall -d adsb20

The following files will be deleted:

/etc/conf/mdevice.d/adsl20 
/etc/conf/pack.d/adsl20/Driver.o 
/etc/conf/pack.d/adsl20/space.c 
/etc/conf/pack.d/adsl20/disk.cfg 
/etc/conf/sdevice.d/adsl20 

or

/etc/conf/mdevice.d/adsb20 
/etc/conf/pack.d/adsb20/Driver.o 
/etc/conf/pack.d/adsb20/space.c 
/etc/conf/pack.d/adsb20/disk.cfg 
/etc/conf/sdevice.d/adsb20 

For SCO UnixWare 2.1:

/etc/conf/bin/idinstall -d adsl

or

/etc/conf/bin/idinstall -d adsb
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The following files will be deleted:

/etc/conf/mdevice.d/adsl
/etc/conf/pack.d/adsl/Driver.o 
/etc/conf/pack.d/adsl/space.c 
/etc/conf/pack.d/adsl/disk.cfg 
/etc/conf/sdevice.d/adsl

or

/etc/conf/mdevice.d/adsb
/etc/conf/pack.d/adsb/Driver.o 
/etc/conf/pack.d/adsb/space.c 
/etc/conf/pack.d/adsb/disk.cfg 
/etc/conf/sdevice.d/adsb

3 Then, rebuild the kernel (0 in -g0 is zero, not the letter O):

/etc/conf/bin/idbuild -B -K
cp /etc/conf/cf.d/unix /unix
cd /
shutdown -g0

4 Reconfigure your computer for your alternate or replacement 
drive controller, and reboot the computer. 
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Troubleshooting

Problems and Solutions

My computer crashes or displays panic messages during the bootup procedure!
You may have to boot from the backup kernel created earlier, and 
then perform the driver update procedure again.

To boot from the old kernel, follow these steps:

1 Reboot the computer.

2 At the Booting UNIX System… prompt or loading UnixWare 
graphics, press the Spacebar.

3 From the [boot]# prompt, first type KERNEL=old kernel (e.g., 
KERNEL=unix.work) and press Enter. Then, type go and press 
Enter. Your computer should now boot from the backup kernel 
created earlier in Installing the Driver When SCO UnixWare is 
Already Installed on page 7-3.

To repeat the driver update procedure, follow these steps:

1 Follow the instructions in Removing the Driver on page 7-9 to 
delete the driver from your computer.

2 Perform the driver update procedure again. See Installing the 
Driver When SCO UnixWare is Already Installed on page 7-3.

Error Messages
The error messages listed below are the messages associated with 
the drivers. Messages are listed sequentially according to the last 
three digits of the error code. For example, [xxxxx020], [xxxxx021], 
[xxxxx022], etc.

Note: When reporting problems to Customer Support, be 
sure to include the complete error code in your problem 
description.
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[xxxxx003] Command completed with error
[xxxxx004] Command completed with error 
[xxxxx005] Command completed with error
[xxxxx006] Command completed with error
[xxxxx007] Command completed with error
[xxxxx008] Command completed with error
[xxxxx009] Command completed with error
A request issued to a target device completed with an indication that 
there is an error. In most cases, the error is recovered and normal 
operation continues.

[xxxxx010] Error issuing command
An error has occurred while the driver was setting up its internal 
data structures. Try installing the most up-to-date version of the 
driver available from the Adaptec Web site or BBS.

[xxxxx011] Error issuing command
The requested command is not supported by this driver.

[xxxxx012] Error issuing command
The driver does not recognize the target device.

[xxxxx013] Error issuing command
[xxxxx014] Error issuing command
An error has occurred while the driver was setting up its internal 
data structures. Try installing the most up-to-date version of the 
driver available from the Adaptec Web site or BBS.

[xxxxx015] Error issuing command
An error has occurred with the driver. Try installing the most up-to-
date version of the driver available from the Adaptec Web site or 
BBS.

[xxxxx020] Adapter or target device not responding or not connected
The target device did not respond to the adapter. If the device is 
present, refer to your host adapter’s user’s guide for 
troubleshooting information. If the device is no longer connected to 
the system, ignore this error.
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[xxxxx021] Target device protocol error
An unexpected event occurred during data transfer between the 
adapter and target device. Normally, this indicates a faulty or non-
compliant target device.

[xxxxx022] Adapter or target device protocol error
The adapter or target device has broken the communication 
protocol. A badly behaving device could be cause this message to 
appear. Normally this is not a serious problem. If you get this 
message frequently over a short period of time, it could indicate that 
the device or system is malfunctioning. Unplug or power down 
unused devices to see if the problem persists.

[xxxxx023] Target device parity error
The driver has detected a parity error by the target device. Try 
decreasing the transfer rate or disable the Ultra SCSI speed in 
SCSISelect. Also, make sure you are using good-quality SCSI cables.

[xxxxx024] Data overrun or underrun
The adapter was given more or less data than was expected.

[xxxxx030] Target Device busy
The target device reports a busy status. Another program might 
already be using this device.

[xxxxx031] Target device queue full
The target device internal buffer is full.

[xxxxx032] Target device busy
The target device reports a busy status. Another program may 
already be using this device.

[xxxxx041] Command aborted
[xxxxx042] Command aborted
[xxxxx043] Command aborted 
[xxxxx044] Command aborted 
[xxxxx045] Command aborted 
An internal condition caused the driver to abort the command. In 
most cases, the command is retried and is recovered, and normal 
operation continues.
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[xxxxx046] Target device did not respond to abort sequence
The target device did not abort the command requested by the 
driver. Some devices do not support the abort command properly. 
Normally, this indicates a faulty or noncompliant target device.

[xxxxx047] Command aborted
An internal condition caused the driver to abort the command. In 
most cases, the command is retried and is recovered, and normal 
operation continues.

[xxxxx048] Unable to abort command
An error occurred while aborting a command. Possibly, the 
command has already completed and there is nothing to abort.

[xxxxx049] Command abort in progress
This indicates an abort command has been issued. This is a normal 
operating condition.

[xxxxx051] Target device did not respond to reset sequence
The target device did not reset correctly as requested by the driver. 
Normally, this indicates a faulty or non-compliant target device.

[xxxxx081] Adapter Initialization Failure
An error has occurred while the driver was setting up its internal 
data structures. Verify that your adapter is supported by this version 
of the driver.

[xxxxx083] Adapter not supported by this version of the driver
Your adapter is not supported by the driver on your system. You 
may have installed a new adapter and have not updated the driver 
on your system.

[xxxxx096] Adapter hardware initialization failure - possible resource conflict
The driver has attempted to initialize the adapter hardware but 
failed. This might suggest that the adapter resources (e.g., IRQ) 
conflict with another board installed in your system.

[xxxxx097] Unable to allocate memory
This indicates that there may be a problem with the amount of 
memory installed in your system. Verify that your system has at 
least the minimum amount of memory required by your operating 
system.
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[xxxxx098] Exceeded maximum number of host bus adapters
The driver has detected more host bus adapters than is supported by 
this version of the driver or operating system.

[xxxxx0a4] SCSI bus reset by third party
Hardware such as an array enclosure may have reset the SCSI bus. 
This is a normal condition unless you receive additional errors.

[xxxxx0a5] SCSI bus reset by host adapter
The host adapter may have reset the SCSI bus. This is a normal 
condition unless you receive additional errors.

[xxxxx0cf] System configuration error
The driver encountered an error with your hardware. Refer to your 
host adapter’s user’s guide for troubleshooting information.

[xxxxx0d0] Command timeout
The target device is either busy, not ready, malfunctioning, or is not 
present. Refer to your host adapter’s user’s guide for 
troubleshooting information.

[xxxxx0d7] Target device scan failed
The driver encountered an error scanning the target device. Refer to 
your host adapter’s user’s guide for troubleshooting information.

❒
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	Introduction
	Device Drivers
	Adaptec 7800 Family Host Adapters
	Requirements


	2
	Microsoft Windows NT Installation
	Installing the Driver When Installing Windows NT
	Completing a Fresh Windows NT 3.5x Installation
	1 If you choose to install Windows NT from a floppy drive, locate the Windows NT Setup Disk 1 for...
	2 Insert the diskette into drive A (not drive B) and turn ON your computer. When prompted, insert...
	3 From the Welcome to Setup Screen, press Enter to set up �Windows NT.
	4 When prompted, select Custom setup.
	5 Press S to skip mass storage device detection. This allows you to manually select the driver fo...
	6 Since mass storage device detection was skipped in the previous step, Windows NT Setup displays...
	7 From the list of additional SCSI adapters, expand the list, select Other, and press Enter (requ...
	8 Insert the Adaptec 7800 Family Manager Set diskette for Windows NT into drive A and press Enter.
	9 Highlight the driver and press Enter.
	10 To add other host adapters that are not a part of the 7800 Family, do so at this time by repea...
	11 Press Enter to continue with the Windows NT operating system setup. Follow the instructions gi...

	Completing a Fresh Windows NT 4.0 Installation
	1 Start your system with the Windows NT Boot �Diskette in the floppy drive.
	2 When prompted, insert diskette #2 in your floppy drive. After a few moments you will see a blue...
	3 Press S to skip auto-detection of your SCSI host adapter.
	4 Press S again to specify an additional device.
	5 Press Enter to select Others; insert the 7800 Family Manager Set diskette for Windows NT in you...
	6 Select from the following drivers:
	7 Highlight a driver and press Enter.
	8 To add other host adapters that are not part of the 7800 Family, press S and repeat from Step 4...
	9 Press Enter to continue with the Windows NT operating �system setup. Follow the instructions on...


	Installing the Driver When Windows NT is Already Installed
	Updating Windows NT 3.5x
	1 Select and start the Windows NT Setup program. (Its icon is usually found in the Main program g...
	2 Select the Options pull-down menu and then select Add/Remove SCSI Adapters. The SCSI Adapter se...
	3 Click the Add button to add another host adapter type to the list. A list of additional SCSI ad...
	4 Expand the list of additional SCSI adapters; select Other and press Enter. (Requires disk provi...
	5 Insert the Adaptec 7800 Family Manager Set diskette for Windows NT into drive A; enter one of t...
	6 Highlight a driver, then click OK. The driver is added to the list of SCSI adapters.
	7 Select the driver from the list of SCSI adapters and click Install.
	8 If the following message appears, click New to replace the existing driver and skip to Step 10.
	9 Change the path to the a:\winnt\3_5 directory, then click �Continue.
	10 When the installation is complete, Windows NT Setup again displays a list of currently install...
	11 Add other types of host adapters if necessary (see step�4 on page�2�5), or click Close to exit...
	12 When you see this message, click OK to exit:
	13 Restart your computer and Windows NT. It is possible that some drive letter assignments may ch...

	Updating Windows NT 4.0
	1 Start Windows NT.
	2 Click the Start button on the Windows NT task bar, and then point to Settings.
	3 Click the Control Panel.
	4 Double-click the SCSI Adapters icon.
	5 Click the Drivers tab, and then click the Add button.
	6 In the Install Driver window, click the Have Disk button.
	7 Insert the 7800 Family Manager Set diskette for Windows NT into drive A.
	8 From the Copy Manufacturer’s File From text box, type a:\winnt\4.0, and click OK.
	9 In the Install Driver window, Click OK.
	10 Click the New button when asked if you want to use the currently installed driver(s) or instal...
	11 Type a:\winnt\4_0 again, and click Continue. The driver is now installed.
	12 You must restart your computer for the changes to take effect. Click Yes to restart your compu...


	Using Advanced Configurable Parameters
	Using Windows NT SCSI Parameters
	1 Select Run from the File menu (Windows NT 3.5x), or Run from the Start button (Windows NT 4.0).
	2 Type regedt32 and press Enter.
	3 Open the registry list to the following location:
	4 Click on the aic78xx or aic78u2 key.
	5 Select Add Key from the Edit menu; Type Parameters in the Key Name edit box. Leave the Class ed...
	6 Click on the �Parameters key.
	7 Select Add Key from the Edit menu; Type Device in the Key Name edit box. Leave the Class edit b...
	8 Click on the Device key.
	9 Select Add Value from the Edit menu. In the Value Name edit box, enter one of the valid paramet...

	Using Driver-specific Parameters
	1 Select Run from the File menu (Windows NT 3.5x), or Run from the Start button (Windows NT 4.0).
	2 Type regedt32 and press Enter.
	3 Open the registry list to the following location:
	4 Click on the aic78xx or aic78u2 key.
	5 Select Add Key from the Edit menu; Type Parameters in the Key Name edit box. Leave the Class ed...
	6 Click on the �Parameters key.
	7 Select Add Key from the Edit menu; Type Device in the Key Name edit box. Leave the Class edit b...
	8 Click on the Device key.
	9 Select Add Value from the Edit menu; type DriverParameters in the Key Name edit box. Enter REG_...
	10 A String Editor text box appears. Enter valid parameters in the text box. When entering multip...


	Using Windows NT and the Host Adapter
	Removing a Host Adapter
	Removing a Host Adapter in Windows NT 3.5x
	1 Start the Windows NT Setup program. There is a brief pause while Windows NT Setup scans your ha...
	2 Select the Options pull-down menu and then select Add/Remove SCSI Adapters. The SCSI Adapter se...
	3 Select the host adapter you want to remove and click the Remove button. When the Windows NT Set...
	4 If you are sure you are removing the correct host adapter type, click OK.
	5 Return to Step 3 to remove driver support for other types of host adapters, or click Close to e...
	6 Close the Windows NT Setup program. When the following message appears, click OK to exit:
	7 Restart the computer.

	Removing a Host Adapter in Windows NT 4.0
	1 From the Control Panel, double-click the SCSI Adapters icon.
	2 Click the Drivers tab.
	3 Select the driver you are planning to remove. The driver appears as one of the following:
	4 Click the Remove button.
	5 If you are sure you are removing the correct host adapter type, click Yes.
	6 Click Yes to restart the computer and initialize changes. Click No to return to the SCSI Adapte...


	Swapping a Host Adapter
	1 Install the driver for the 7800 Family host adapter by following the steps in Installing the Dr...
	2 Once the new device driver is installed, shut down Windows NT and replace the existing host ada...
	3 Restart your computer and Windows NT. It is possible that some drive letter assignments may cha...


	Troubleshooting
	Problems and Solutions
	I made changes to the host adapter configuration and Windows NT no longer boots!
	1 Undo any hardware changes you have made to the computer since it was last operational.
	2 Reboot the computer. Watch the display carefully during bootup. If the following message appear...
	3 Once your computer is operational again, check all of the hardware and software configuration c...


	Error Codes
	1 Double-click the Event Viewer icon in the Administrative Tools program group.
	2 To view event details, select System from the Log menu. �Double-click the aic78xx.sys or aic78u...
	3 Click the Words radio button.
	aic78xx.sys or aic78u2.sys Error Codes
	[xxxxx004] [xxxxx005] [xxxxx006]
	[xxxxx010]
	[xxxxx011]
	[xxxxx012] [xxxxxx99]
	[xxxxx021]
	[xxxxx022]
	[xxxxx023]
	[xxxxx024]
	[xxxxx031]
	[xxxxx032]
	[xxxxx050] [xxxxxx9A]
	[xxxxx081] [xxxxxx8A] [xxxxxx83]
	[xxxxx089]
	[xxxxx096]
	[xxxxx097]
	[xxxxx0af]
	[xxxxx0ce]
	[xxxxxd4]
	[xxxxx0d6]
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	Microsoft Windows 95 Installation
	Installing the Driver When Installing Windows 95
	Installing the Driver When Windows 95 is Already Installed
	1 Start Windows 95.
	2 Click the Start button on the Windows 95 task bar, and then point to Settings.
	3 Click Control Panel.
	4 Double-click the System icon.
	5 On the Device Manager tab, click the plus sign (+) next to the SCSI controller icon.
	6 Double-click the 7800 Family host adapter you wish to update, or if a yellow question mark labe...
	7 Insert the Adaptec 7800 Family Manager Set v.3.00 diskette into drive A.
	8 Select the Drives tab
	9 Click Change Driver. If you are prompted to select the hardware type, select SCSI �Controller.
	10 Click the Have Disk button and enter a:\win95 as the path.
	11 Click OK.
	12 Select the 7800 Family host adapter, and click OK.
	13 Click OK. The driver is copied and scanned.
	14 You must restart your computer for the changes to take effect. Click Yes to restart your compu...

	Updating the Driver for Windows 95 (Version OSR 2)
	1 Follow steps 1 through 7 in the previous section, Installing the Driver When Windows 95 is Alre...
	2 Click Update Drivers.
	3 In the Update Device Driver Wizard, select Yes, then click Next.
	4 Under Location type a:\win95, then click OK.
	5 Click Finish.
	6 The message Please insert the disk labeled ‘7800 Family Manager Set v.3.00 Installation Disk’ a...
	7 In the Copying Files dialog box, a message stating that ‘The file AIC78XX.MPD or AIC78U2.MPD on...
	8 Click Yes to restart you computer to update the changes. To return to the System Properties win...

	Troubleshooting
	Problems and Solutions
	What is a miniport driver, and how do I make sure that the miniport driver for my host adapter is...
	What if there is no SCSI Controllers icon under Device Manager, or the model name of the host ada...
	1 Open Control Panel and double-click the Add New Hardware icon. Let Windows search for the host ...
	2 If Windows does not detect the adapter, run the Add New Hardware Wizard again. This time, selec...
	3 Insert the 7800 Family Manager Set diskette for Windows 95 into your floppy drive.
	4 Select the model of your 7800 Family host adapter, and then click the Have Disk button.
	5 Enter a:\win95 or b:\win95 as the location to copy the file from.
	6 Click OK. The driver is copied and your system is updated.
	7 You must restart your computer for the changes to take effect.

	What if a yellow exclamation mark or a red X appears in Device Manager in front of my host adapter.
	What do I need to do if I change or upgrade my host adapter?
	1 Open the Control Panel, double-click on System, and click the Device Manager tab.
	2 Double-click the SCSI Controllers icon, select the name of the old host adapter, and click Remove.
	3 Turn OFF the computer and physically remove the currently installed host adapter.
	4 Install the new host adapter according to the instructions in the hardware documentation.
	5 Turn the computer ON. If the new host adapter supports Plug and Play, Windows will install and ...

	If I am running under Windows�95, do I need lines for the Adaptec real mode ASPI drivers and �msc...
	My CD�ROM drive doesn’t work properly under Windows�95.
	1 Make sure your ASPI Real mode drivers (including aspicd.sys, aspi8dos.sys, and mscdex.exe) are ...
	2 If step 1 did not work, find the file named cdtsd.vxd in the \windows\system\iosubsys directory...

	My CD�ROM drive shows up as more than one icon under My �Computer.
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	Novell NetWare Installation
	Installing the Driver When Installing NetWare
	NetWare v3.1x
	1 Follow the procedures in your NetWare documentation for installing a new server.
	2 After completing the NetWare installation, exit to DOS.
	3 Copy all the files from the NetWare 3.12 Patch Disk to the c:\server.312 directory. Do this wit...
	4 Update the server.exe file with the following command:
	5 Create the startup.ncf with the following lines:
	6 Start server.exe and continue with the installation.

	NetWare v4.0 or v4.1x
	1 Begin installation of NetWare v4.0 or v4.1x on your server as instructed in your NetWare docume...
	2 When a screen appears that asks you to select a disk driver, press Insert.
	3 Insert the Adaptec 7800 Family Manager Set diskette for NetWare into your disk drive.
	4 Press F3 and specify the path to the aic7870.dsk or aic78u2.ham driver for �NetWare (e.g., a:\n...
	5 Select AIC7870.DSK or AIC78U2.HAM and press Enter.
	6 Press Alt-ESC. From the console prompt type the following:
	7 Press Enter. A list of slot numbers separated by commas is displayed. Write down all slot numbe...
	8 Press ESC twice.
	9 At the prompt, press Alt-ESC.
	10 Choose Select/Modify Driver Parameters then press Enter.
	11 Type the slot number and press Enter.
	12 Press F10, or ESC.
	13 Choose Save Parameters and Continue, and press Enter.
	14 To install additional adapters, follow the procedures from step 10.
	15 When complete, select Continue the Installation to complete the installation.


	Installing the Driver When NetWare is Already Installed
	1 Make a backup copy of the old driver (if it exists) before installing the new driver.
	2 Copy the aic7870.dsk or aic78u2.ham driver from the 7800 Family Manager Set diskette for NetWar...
	3 If necessary, modify the load command line in the startup.ncf file so that the proper path to t...

	Loading the Driver at Server Bootup
	1 Type load install at the NetWare prompt and press Enter.
	2 Select the appropriate menu choice that allows you to edit the startup.ncf file.
	3 Make the necessary changes. When you are done, press Esc.

	Using the Load Command Line Options
	Table of aic7870.dsk Command Line Options:
	Table of aic78u2.dsk Command Line Options
	Bit Mask Options
	Sample Load Commands

	Using NetWare and the Host Adapter
	Using Removable Media
	1 Load monitor.nlm to display the various options.
	2 Select Disk Information. All system disk drives appear.
	3 Select the removable-media device. The following drive status items appear:
	Mount Status
	Lock Status
	Verify (aic7870.dsk driver only)

	Using the NetWare Tape Backup
	1 Once you have loaded aic7870.dsk or aic78u2.ham, load tapedai.dsk, tsaxxx.nlm (tsa312.nlm, tsa4...
	2 When sbackup is loaded, it asks for a login name. Enter the appropriate name.
	3 If sbackup asks you to select the device driver, select the HP DIBI-2 Tape Driver, regardless o...

	Using a CD-ROM with NetWare
	1 Load aic7870.dsk or aic78u2.ham by entering the following line:
	2 If using an Ultra SCSI host adapter, load aspicd.dsk by entering the following line:
	3 Load cdrom.nlm by entering the following line:
	4 Enter the following line at the prompt and then note the �number and name of the CD:
	5 Enter the number or volume name of the CD at the command line:

	Optimizing Performance

	Troubleshooting
	Error Messages
	[xxxxx080] Unable to allocate memory
	[xxxxx081] Adapter software initialization failure
	[xxxxx082] Internal driver error
	[xxxxx083] Adapter not supported by this version of the driver
	[xxxxx084] Adapter software initialization failure
	[xxxxx085] Unable to allocate memory
	[xxxxx087] Internal driver error
	[xxxxx088] Adapter software initialization failure
	[xxxxx089] Unable to allocate memory
	[xxxxx096] Adapter hardware initialization failure - possible resource conflict
	[xxxxx099] Adapter software initialization failure [xxxxx09a] Adapter software initialization fai...
	[xxxxx0ab] Driver already loaded for this host bus adapter
	[xxxxx0ac] Driver already loaded for all host bus adapters
	[xxxxx0a4] SCSI bus reset by third party hardware
	[xxxxx0a7] Unable to allocate memory [xxxxx0a8] Unable to allocate memory
	[xxxxx0a9] Possible interrupt conflict
	[xxxxx0c9] Invalid command line parameter
	[xxxxx0ca] Invalid command line syntax [xxxxx0cb] Invalid command line syntax [xxxxx0cc] Invalid ...
	[xxxxx07c] Unable to allocate memory [xxxxx07d] Unable to allocate memory [xxxxx07e] Unable to al...




	5
	IBM OS/2 Installation
	Installing the Driver When Installing OS/2
	Installing OS/2 v2.1x (Ultra SCSI Driver Only)
	1 Go to a computer on which DOS, Windows®, or OS/2 is already installed. Use diskcopy to make bac...
	2 Delete some of the existing files on the backup copy of the OS/2 diskette #1 so that approximat...
	3 Copy the os2ldr file from the 7800 Family Manager Set diskette for OS/2 (i.e., \os2\aic7870\) o...
	4 Copy the ibmint13.i13 and the aic7870.add files from the 7800 Family Manager Set diskette for O...
	5 Add the following line to the config.sys file on diskette #1:
	6 Run the OS/2 v2.1x installation program; follow the instructions in your OS/2 documentation.
	7 At the end of the installation process, follow the onscreen instructions to remove the last OS/...
	8 After the computer has restarted, OS/2 displays a welcome screen. You have the option to view o...

	Installing OS/2 Warp 3.x, 4.x, and 4.x SMP
	1 Go to a computer on which DOS, Windows, or OS/2 is already installed. Use diskcopy to make back...
	2 Delete some of the existing files on the backup copy of the OS/2 installation diskette #1 so th...
	3 Copy the aic7870.add or aic78u2.add driver from the 7800 Family Manager Set diskette for OS/2 o...
	4 For each driver removed from the OS/2 diskette #1, remove its corresponding line in the config....
	5 In the config.sys file on OS/2 diskette #1, add the following line:
	6 Run the OS/2 installation program; follow the instructions in your OS/2 documentation until you...
	7 In the System Configuration windows, click the SCSI Adapter Support icon.
	8 Deselect any highlighted adapters (including the Adaptec 294x, 394x, AIC7870 PCI SCSI), and cli...
	9 Follow the instructions in your OS/2 documentation to �complete the installation.


	Installing the Driver When OS/2 is Already Installed
	1 If you are updating the driver, simply copy the aic7870.add or aic78u2.add driver from the 7800...
	2 Run the ddinstal program by selecting the Device Driver Install icon from the System Setup fold...
	3 Insert the Adaptec 7800 Family Manager Set diskette for OS/2 in the appropriate disk drive and ...
	4 The computer scans for the host adapter(s). If a host adapter is found, the Installing Device D...
	5 Reboot the computer for the changes to take effect.

	Using Command Line Options
	Universal Parameters
	/et
	/!et
	/v
	/pcihw
	/!pcihw

	Adapter ID
	/a:n

	Unit Parameters
	/dm:x,y,z
	/!dm:x,y,z
	/sm:x,y,z
	/!sm:x,y,z
	/tag:x
	/i
	/ur
	/!ur

	Command Line Examples
	Example 1
	Example 2


	Troubleshooting
	Problems and Solutions
	How do I assign an interrupt for the host adapter?
	During installation, OS/2 fails to find the hard drive.
	Does extended translation need to be enabled on the host adapter to support drives greater than 1...

	Error Messages
	[xxxxx080] Unable to allocate memory
	[xxxxx081] Adapter software initialization failure
	[xxxxx082] Internal driver error
	[xxxxx083] Adapter not supported by this version of the driver
	[xxxxx084] Adapter software initialization failure
	[xxxxx085] Unable to allocate memory
	[xxxxx087] Internal driver error
	[xxxxx088] Adapter software initialization failure
	[xxxxx089] Unable to allocate memory
	[xxxxx096] Adapter hardware initialization failure - possible resource conflict
	[xxxxx099] Adapter software initialization failure [xxxxx09a] Adapter software initialization fai...
	[xxxxx0a7] Unable to allocate memory
	[xxxxx0a9] Possible interrupt conflict
	[xxxxx0c9] Invalid command line parameter
	[xxxxx0ca] Invalid command line syntax [xxxxx0cb] Invalid command line syntax [xxxxx0cc] Invalid ...
	[xxxxx07c] Unable to allocate memory [xxxxx07d] Unable to allocate memory [xxxxx07e] Unable to al...
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	SCO UNIX Installation
	Installing the Driver When Installing SCO UNIX
	Installing SCO UNIX 3.2 v4.2, SCO ODT 3.0, or SCO �OpenServer 3.0
	1 Insert the SCO UNIX N1 (Boot) floppy diskette into the primary floppy drive and turn ON the com...
	2 When you see these prompts
	3 Type alad or blad as the package you want linked to the system and press Enter.
	4 Insert the requested volume (7800 Family Manager Set diskette for SCO UNIX) in the floppy drive...
	5 When prompted to insert the SCO UNIX N2 (Filesystem) diskette, remove the 7800 Family Manager S...
	6 Follow the procedures in your SCO UNIX documentation for completing the installation until you ...
	7 After completing the Password procedure, a message similar to the following appears:
	8 Type alad or blad and press Enter. The alad driver for your 7800 Family host adapter has been r...

	Installing SCO OpenServer 5
	1 Insert the SCO OpenServer 5 Boot floppy diskette into the primary floppy drive and turn ON the ...
	2 When you see these prompts
	3 Type alad325 or blad325, or type ahslink for OpenServer 5.00, as the package you want linked to...
	4 Insert the requested volume (i.e., the 7800 Family Manager Set diskette for SCO UNIX) in the fl...
	5 If the above message does not appear, skip to step 6. Otherwise, enter the corresponding number...
	6 If the driver is properly loaded, the following message appears:
	7 Insert the Boot floppy diskette and press Enter.


	Installing the Driver When SCO UNIX is Already Installed
	Perform a System Backup
	1 Log in as root.
	2 For SCO 3.2v4.2 based UNIX: To back up the current kernel configuration, type the following and...
	3 This step is optional. For extra security, you may back up the mdevice file and the sdevice.d d...

	Use the Install Package
	1 At the UNIX system prompt, type installpkg and press Enter. The screen then displays these mess...
	2 Insert the 7800 Family Manager Set diskette for SCO UNIX and press Enter. The screen then displ...
	3 At this point, type alad or blad (or alad325 or blad325 for SCO OpenServer 5) and press Enter. ...

	Modify the mscsi File
	1 Enter this command:
	2 Enter this command to copy the file:
	3 Use a text editor to edit this file. Enter the following command if using the vi editor:
	4 Search for all entries with the host adapter number 0 (zero). The host adapter number is the th...
	5 Modify the mscsi file according to your hardware setup:


	ad eiad spad arad smad alad blad
	embedded embedded embedded BTLD BTLD BTLD BTLD
	AHA-1540/1640 family AHA-1740 family AIC-6260 family AIC-7770 family AIC-6260/6360 family
	AIC-78xx, AIC-7895 AIC-789x
	6 Save the file and exit the text editor.
	Rebuild the UNIX Kernel
	1 Type the following at the # prompt and press Enter after each line:
	2 When the kernel has been built, shut down the system by �typing haltsys and pressing Enter.
	3 Turn OFF the system power when you are prompted to do so.

	Boot the New Kernel
	1 Follow the onscreen instructions to reboot your system, usually by pressing Enter.
	2 Check the host adapter BIOS messages to verify that all your installed SCSI devices are listed.
	3 Wait for UNIX to complete bootup with the new kernel.

	Using SCO UNIX and the Host Adapter
	Using Multiple Host Adapters
	Changing the Boot Disk
	Using Wide SCSI Host Adapters and Devices
	Using Tunable Parameters for the alad Driver
	Setting Parameters
	Examples


	Enabling Scatter/Gather and Tagged Queuing

	Troubleshooting
	Problems and Solutions
	In SCO OpenServer 5, my system hangs after I have installed the driver and rebooted the system.
	I have problems using my SCSI devices.
	My computer does not recognize my host adapter.
	I am having problems booting the computer from a SCSI drive.
	My computer crashes or displays panic messages during the bootup procedure.
	1 Reboot the system.
	2 At the Booting UNIX System... prompt, type unix.orig and press Enter.


	Error Messages
	[xxxxx020] Adapter or target device not responding or not connected
	[xxxxx022] Adapter or target device protocol error
	[xxxxx030] Target device busy [xxxxx032] Target device busy
	[xxxxx09D] Unexpected interrupt
	[xxxxx0a3] Adapter diagnostic failure - possible resource conflict
	[xxxxx0ca] Cannot initialize device
	[xxxxx0cb] Unable to allocate memory. Decrease alad_instr_buffersz in space.c
	[xxxxx0cc] CONFLICT: Disconnection must be enabled in order for tag-queueing to work
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	SCO UnixWare Installation
	Installing the Driver When Installing SCO UnixWare
	1 Insert the Install diskette of the SCO UnixWare package into the floppy boot drive. Reboot your...
	2 When prompted to either Install Host Bus Adapter Drivers or Continue Installation, first remove...
	3 Insert the 7800 Family Manager Set diskette for UnixWare 2.x into the primary floppy drive and ...
	4 If you have additional HBA diskettes, insert the next HBA diskette, select Install Another HBA ...
	5 If necessary, enter the DCU (Device Configuration Utility) to view/change the SCO UnixWare devi...
	6 Follow the onscreen instructions to continue with installation. Refer to the SCO UnixWare docum...

	Installing the Driver When SCO UnixWare is Already Installed
	Back Up the Computer
	1 Log in as root at the UnixWare # system prompt.
	2 To back up the old SCO UnixWare kernel, type the following and press Enter:
	3 To back up the old configuration file, type the following and press Enter:

	Load the Package
	1 At the system prompt, type the following and press Enter:
	2 Select the adsl20/adsl or adsb20/adsb package from the onscreen menu and press Enter. The packa...
	3 When the package has loaded, you may be prompted to install the diskette again.
	4 Type mail and press Enter. The mail messages tell you if the installation was successful.
	5 Type pkginfo and press Enter.
	6 Verify that the adsl20/adsl or adsb20/adsb driver is now listed. The adsl20/adsl or adsb20/adsb...

	Modify the New System File
	1 Display the contents of the adsl20/adsl file or adsb20/adsb by typing the �following and pressi...
	2 If your computer is to boot from a device connected to a 7800 Family host adapter, verify that ...
	3 If your computer is not to boot from the host adapter SCSI bus, and you wish to leave the drive...

	Rebuild the SCO UnixWare Kernel
	1 Type the following at the # prompt and press Enter after each line:
	2 When the kernel has been built, type the following and press Enter after each line (0 in -g0 is...
	3 Type y and press Enter when the computer asks if you really want to shut down. System Is Down s...

	Boot the New Kernel
	1 Follow the onscreen instructions (usually by pressing Enter) to reboot your computer.
	2 Check the bootup messages to verify that all your installed SCSI devices are listed.
	3 Wait for SCO UnixWare to complete bootup with the new �kernel.


	Using SCO UnixWare and the Host Adapter
	Using Tunable Parameters
	Using Multiple Host Adapters
	Removing the Driver
	1 Back up all important computer files.
	2 At the UnixWare root prompt, type the �following:
	3 Then, rebuild the kernel (0 in -g0 is zero, not the letter O):
	4 Reconfigure your computer for your alternate or replacement drive controller, and reboot the co...


	Troubleshooting
	Problems and Solutions
	My computer crashes or displays panic messages during the bootup procedure!
	1 Reboot the computer.
	2 At the Booting UNIX System… prompt or loading UnixWare graphics, press the Spacebar.
	3 From the [boot]# prompt, first type �KERNEL=old kernel (e.g., KERNEL=unix.work) and press Enter...
	1 Follow the instructions in Removing the Driver on page�7�9 to delete the driver from your compu...
	2 Perform the driver update procedure again. See Installing the Driver When SCO UnixWare is Alrea...


	Error Messages
	[xxxxx003] Command completed with error [xxxxx004] Command completed with error [xxxxx005] Comman...
	[xxxxx010] Error issuing command
	[xxxxx011] Error issuing command
	[xxxxx012] Error issuing command
	[xxxxx013] Error issuing command [xxxxx014] Error issuing command
	[xxxxx015] Error issuing command
	[xxxxx020] Adapter or target device not responding or not connected
	[xxxxx021] Target device protocol error
	[xxxxx022] Adapter or target device protocol error
	[xxxxx023] Target device parity error
	[xxxxx024] Data overrun or underrun
	[xxxxx030] Target Device busy
	[xxxxx031] Target device queue full
	[xxxxx032] Target device busy
	[xxxxx041] Command aborted [xxxxx042] Command aborted [xxxxx043] Command aborted [xxxxx044] Comma...
	[xxxxx046] Target device did not respond to abort sequence
	[xxxxx047] Command aborted
	[xxxxx048] Unable to abort command
	[xxxxx049] Command abort in progress
	[xxxxx051] Target device did not respond to reset sequence
	[xxxxx081] Adapter Initialization Failure
	[xxxxx083] Adapter not supported by this version of the driver
	[xxxxx096] Adapter hardware initialization failure - possible resource conflict
	[xxxxx097] Unable to allocate memory
	[xxxxx098] Exceeded maximum number of host bus adapters
	[xxxxx0a4] SCSI bus reset by third party
	[xxxxx0a5] SCSI bus reset by host adapter
	[xxxxx0cf] System configuration error
	[xxxxx0d0] Command timeout
	[xxxxx0d7] Target device scan failed
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